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Welcoine 

Welcome to the SCO ImageBuilder drawing and charting program. 

Now you can easily create professional-looking graphics for your 

presentations and publications. SCO ImageBuilder turns your infor­

mation into impressive 35mm slides, transparencies, or printed and 

plotted output. 

Create text charts, organization charts, diagrams, and free-form 

drawings with the program's Draw menu. Combine pictures, en­

hance data charts or incorporate pre-drawn symbols into your im­

ages. Produce attractive bar, line, area, pie, scatterplot, and mixed­

type charts with the program's powerful Chart capability. Enter your 

data directly or import values from an SCO Professional™ worksheet. 

Produce output on a printer or plotter attached to your computer, or 

transmit images to the MAGICorp™ slide service for fast processing 

as high-quality 35mm slides and transparencies. 

SCO lmageBuilder works with other SCO applications. Transfer 

SCO ImageBuilder images to SCO Lyrix™ for integration with text in 

a document. If you wish, bring data from SCO Professional or SCO 

FoxBASETM into the program's charting area. 
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About This Guide 

The SCO ImageBuilder User's Guide is designed to provide both 

beginning and expert users with easy access to program information. 

The User's Guide is divided into three sections: ·� 

Part One: Introduction 

Introduces you to the basics of creating good graphics. Discusses 

using visuals to enhance written and verbal presentations. Provides 

an overview on how to use the program, including such basics as 

selecting menu items and getting Help. Read this section first. 

Part Two: SCO ImageBuilder Tutorial 

Takes you through four exercises, about 15 minutes each, to acquaint 

you with fundamental program functions. Going through the exer­

cises in the tutorial is the best way to quickly become familiar with 

operating the program. 

Part Three: Command Reference 

Describes each command and gives step-by-step instructions for per­

forming tasks. Refer to this section for detailed information on using 

the program. 
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Good Graphics Get Noticed 

Good graphics strengthen your presentations .  Many studies have 

shown that attractive proj ected visuals,  such as 35mm slides and 

transparencies ,  actually increase a speaker ' s  power to persuade.  

Printed charts  and diagrams can be equally beneficial .  An il­

lustrated report,  for instance, is more likely to  receive favorable 

attention than a report with no graphics . 

You can easily create the graphics you need for presentations and 

publications with SCO ImageBuilder .  To use the program suc­

cessfully, you don't  need to have artistic talent ,  j ust  the ability to  

follow a few simple graphic rules .  This  sect ion presents  some t ips  

on how to create  the most  effective graphic images  possible .  

Choosing The Right Medium 

Once  your images a re  created, you can transform them in to  out­

put in one of several  ways . A printer or plotter attached t o  your 

computer creates paper hardcopy. Images can be  t ransferred to 

SCO Lyrix m to  publish in a document .  Or ,  you can automatical­

ly t ransmit your images to  the MAGICorpm slide service for 

processing as high- quality 35mm slides,  transparencies ,  color 

prints ,  or  black-and-white copies .  

1-1 
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Paper Output 

Paper output can be used to  illustrate reports ,  display on the wall, 

supply camera-ready art ,  or serve as a record of  a slide presen­

tat ion.  A quickly printed chart may clarify complex data for your 

own use in writing a letter or report .  A budget request you sup­

plement with graphics may elicit more dollars than one presented 

without visuals . As a speaker, you can make a lasting impression 

by supplying your audience with handouts of your most important 

proj ected images .  

Y o u  c a n  u s e  a graphics printer or plotter to  create paper 

hardcopy, or  obtain color photographs or black-and-white 

printed copies of your images from the MAGICorp slide service . l 
In  addition, you can integrate graphics and text in documents by 

transferring a picture or chart to  SCO Lyrix. 

35mm Slides 

No medium makes you look more professional than 35mm slides .  

Sl ides help you convey an image of polish and credibility. 

Proj ected slides are sharp, colorful, and impressive .  Your 

audience is more likely to  remember you and your message when 

you back up your ideas with vivid slide images .  

If  you have a large audience, slides are the  bes t  media choice. 

Images with dark-colored backgrounds and lighter,  contrasting ·� 
text and charts make the best slides .  If possible,  do a test  run 

with a slide proj ector in the room you plan to  use,  to  make sure 

1-2 
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.� your graphics are legible from the back of the room, and that your 

slides are all upright in the carousel .  The MakeSlide command 

lets you transmit your images to the MAGICorp slide service for 

expert  processing. S lides come back to  you via overnight courier .  

("Exercise 4 :  M aking Slides" in Part Two: SCO lmageBuilder 

Tutorial  gives step-by-step instructions for sending images to  

MAGICorp . )  

Transparencies 

I f  you are presenting information to  a small audience, consider 

using overhead transparencies .  Transparencies allow you to  use 

normal room lighting, so audience members can easily make 

notes ,  and you can maintain eye contact with people.  You create 

a friendly atmosphere with transparencies .  

I t ' s  a good idea  to  use more intense colors  for transparency 

graphics,  as pastels may become washed out when proj ected .  

Choose neutral  to  medium-dark background colors l ike gray, 

white and blue . Test your transparencies by p osit ioning them 

against  a l ight wall .  If you can read them at a distance of 10 feet ,  

they wi l l  proj ect well .  

You can produce transparencies on a plotter or  obtain them from 

the MAGICorp sl ide service .  Transparencies require an extra  

day of processing. 

1-3 
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Giving a Good Presentation 

You can use SCO lmageBuilder to  enhance your next presenta­

t ion with professional-looking 35mm sl ides or transparencies .  

Visuals will support you, but there's nothing like planning ahead 

and knowing what you're going to say for making a sound presen­

tation . 

Plan your presentation 

Be sure of your purpose . State your main point when you begin 

and end your presentation.  Focus on a few maj or concepts .  

D evelop a logical flow of material, presenting information from l 
simple to  complex, familiar to new, factual to  theoretical .  

Create well-designed visuals 

This program has everything you need to  turn your data into 

professional- looking visuals, especially if you are aware of some 

simple rules for  creating good graphics. The following tips may 

help you avoid creating ho-hum or bad graphics that  could dis ­

tract  audience attention from you and your message : 

• Keep It simple.  Use only a few words or a small 

amount of data in each graphic.  The visual is  

there to  support you, not to entertain.  The more 

direct the image, the easier it  is  for the audience 

to  absorb .  

1-4 
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• Make the page look good. Keep the visual weight 

between text and graphics balanced. Leave plenty 

of white space around text and graphics .  Make 

bottom margins larger than top margins . 

• Unify your presentation. Use only a few colors 

from the same color palette throughout your 

presentation.  Keep text styles and text sizes the 

same for al l  your images . A border or a simple 

logo added to  every visual provides pleasing con­

sistency. 

Rehearse your presentation 

Make sure your equipment works and that each visual is legible 

at  a distance (and right side up!) when proj ected .  Check to  en­

sure that  your slides or transparencies are in  the right order .  Be 

comfor table with your graphics, so you can focus your attention 

on your l isteners .  Good,  well-rehearsed graphics give you con­

fidence -- an attitude you'll  naturally convey to  the audience.  

Build ing a Better Text Chart 

Text charts are graphic images composed of words and simple , 
graphics,  as shown in Figure 1-1. Text charts may comprise as 

much as 80% of  a presentation. You can use text charts t o  cue 

your topics and focus the audience on your key points .  S howing 

a series  of text chart slides, each with a line of text added,  until  

a complete t ext chart is presented, rivets interest on your next 

1-5 
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Title 
Bullet point 
Bullet point 
Bullet point 

............................ 

ILOGOI 
Figure 1-1 A sample text chart 

point .  ( "Exercise One:  Creating a Text Chart" in Part Two: SCO 

ImageBuilder Tutorial tells you how to create a t ext char t . )  

Keep in mind the  following tips as you  create text chart images:  

• Layout  of a text chart should be clear and simple, 

so  the audience can quickly read and understand 

its  contents .  The most effective text charts are 

composed of 1 or 2 t i t les and up to  6 l ines of text 

with no more than 6 words per line .  Use key 

words and phrases instead of sentences .  Separate 

each concept with an identifying number or bullet 

1-6 
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(symbol  marker) . Leave ample margins and plenty 

of  white space between lines .  

• Fonts are lettering styles .  Limit yourself to  2 

fonts used consistently in all text charts .  Use one 

font for tit les and text ,  and a second only when 

you need to  emphasize a key word or phrase .  In 

general ,  boldface fonts are easiest to read.  Text 

that combines upper- and lower-case letters is  

most legible .  Make your letters large enough to  

be seen from the  back of the  room when proj ected.  

• Color works best if you limit yourself to  2 colors 

for your text ,  and use the same colors for all the 

text charts throughout your presentation.  Now 

and then, you can use a third,  brighter color to 

call attention to  key points .  A good contrast be­

tween background and text colors is essential for 

legibility. 

Building a Better Data Chart 

Numbers scrawled on a board at the front of a room mean little 

to  viewers who still  have to  calculate their relationship. Even if 

you are showing findings informally to  peers, the program's at­

tractive line, bar ,  area, pie, scatter,  and mixed charts al low others 

to  understand quickly the meaning behind the numbers .  

Use SCO ImageBuilder to  construct your charts,  and you wil l  find 

that most  of  the work has been done for you. Figure 1 -2 shows a 

default vertical b ar chart, which is automatically drawn when 

1-7 
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Figure 1-2 Default vertical bar chart 

data is entered into the program. The program automatically 

creates color-coordinated charts and graphically correct labels, 

legends and axes. You can easily see your data plotted in a 

variety of chart types. You can even bring SCO Professional ... 

spreadsheet data or SCO FoxBASE ... data into the program's 

data area. 

("Exercise Two : Creating a Data Chart" and "Exercise Three: En­

hancing Your Chart" in Part Two: SCO ImageBui/der Tutorial give 

step-by-step instructions for creating and enhancing data charts.) 

Keep in  mind the following tips as you create your charts: 

1-8 

• Layout for charts should have a big, bold,  "clean" 

look that can be read easily from a distance. Keep 

your chart simple, so viewers can quickly under­

stand its meaning. You can emphasize a par­

ticular aspect of your data with graphic enhance­

ments like arrows or bright colors. 
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• Data should be kept to a minimum in a chart . 

M ake sure your data is correct before you proj ect 

i t  for the world to see. Put the source of your 

data at the bottom of the chart .  Even if it 's not 

truly legible from the back of the room, the 

audience knows i t ' s  there and finds the chart more 

credible . 

• Labels used sparingly give your chart an unclut­

tered appearance . Position labels to  read from 

left to  right .  You may elect  to  remove or  simplify 

some of the finer text that appears along the axes .  

In l ieu of a legend, you cim o p t  to label individual 

bars ,  l ines,  and areas directly . 

. � • Color  has impact . Choose colors that seem ap-

propriate to  the type of audience you will be  ad­

dressing.  Limit yourself to a few colors per  chart . 

D isplay the most important part of the chart in 

the brightest color,  so the eye wil l  be drawn t o  it 

firs t .  Arrange darker colors,  like blue and green, 

before lighter colors,  like yellow and orange . 

Avoid use of red and green to  compare crucial 

values on a chart ,  because some people have dif­

ficulty distinguishing between those colors .  

Using the Program 

� This section describes the basics of operating the SCO Image­

B uilder .  I t  familiarizes you with the overall  structure of the 

program and tel ls  you how to perform general tasks .  

1-9 
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Setting Up and Starting the Program 

You need a graphics terminal to run the program, and a graphics 

printer or  plotter to produce paper output. (For instructions on 

setting up the program with your output device, refer  to the 

Release an d In stallation Notes that came with the SCO I mage­

B uilder manual,  or contact your system administrator.)  

To start the program: type image at the prompt, and press 

< Return > .  

Using the Screen 

SCO ImageBuilder is composed of sever al levels of menus. A 

m en u  is a l ist of choices. The choices are called com m an ds. At 

the top of the screen, as shown in Figure 1·3, there are three lines 

of information:  

Menu l in 

Prompt l i  

Graphics 

Area 

1-10 
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• The firs t  line is called the status line .  I t  shows all 

the menu commands you have selected to  reach 

your current place in the program. You can see  

how deep you are in the program's  menu levels 

with a glance at the status line .  For example,  if  

the status l ine reads "Draw/Create/Text , "  you are 

three levels deep.  (To move up through menu 

levels ,  press < ESC > until  you reach the menu 

you want . )  

• The second line is called the men u  line .  I t  dis­

plays the menu of the currently selected com­

mand.  For example,  if you had j ust  selected 

Draw, the menu line would show the Draw menu:  

"Create ,  Modify, Erase,  Transfer, Print ,  File, 

Zoom, AddChart,  and Quit . " You select a com­

mand on the menu line to  continue performing a 

function.  

• The third line is called the prompt line .  I t  

describes the  action you  can  perform with the  com­

mand that the cursor currently touches .  When you 

reach a point of entering information into the 

program, the prompt line tells you what t o  do next . 

B elow the three lines of information, the main port ion of  the 

screen contains one of the following: 

• A graphics area,  which is a blank area on the 

screen in which a picture or chart  is  drawn. The 

screen s idebar on the right side of the graphics 
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area contains information about the current pic­

ture or char t .  

• A display in which you select or enter information.  

S ome displays contain fields in which you enter in­

formation or select a choice . There are also lists 

from which you select items. 

NOTE: Help is available on any menu command, option, or  field 

in a display the cursor touches, by pressing < Fl > . 

Selecting an Object or Location in the Graphics Area 

To create pictures in the Draw graphics area, you move the cur­

sor  to  an obj ect or location, a'nd then press < Return > . You can 

move the cursor in a number of ways to create obj ects :  

Use the arrow keys to move the cursor up, down, left, or  right .  

Use  the < Home > ,  < End > , < PGUP > , and < PGDN > keys to 

move the cursor diagonally. Press and hold the < Shift > key 

while pressing one of the cursor keys to move the cursor in very 

small steps,  for precision drawing. 

You can instantly center the cursor in the graphics area by press­

ing < Shif t > < Numeric Pad 5 > . When you are selecting an ob­

j ect to  modify, move the cursor to  a corner of the obj ect ,  to  en­

sure select ion of the r ight obj ect .  

1-12 



Introduction 

Using Menus 

The S C O  ImageBuilder main menu is the top level menu that ap­

pears when you start  the program. All other menus branch off 

from the main menu . 

To perform a function, you select (activate)  one command from 

each of  several menus until you reach a point where you are asked 

to  enter  information into the program. For example :  to  create 

text ,  you select the Draw command from the main menu . Then 

you select Create from the Draw menu . The Create menu ap­

pears ,  and you select Text .  At that point , you begin the process 

of actual text entry. 

Selecting a Menu Command 

There are two ways to  select a menu command: 

• Move the cursor along the menu line (with the 

< Right > and < Left > arrow keys or a mouse) to 

the command of your choice, and press the 

< Return > key.  

• Press  the first  letter key of the command. 

Selecting From Options Menus 

S ome menus are made up of options (drawing characteristics for 

obj ects or charts) . Options menus may contain more choices 

than fit on the menu line . A small arrow appears on the right end 
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of the visible choices .  To scroll the menu line so that you may see 

al l  the choices,  move the cursor over the arrow. 

NOTE: S ome options menus contain more than one item begin­

ning with the same first  letter .  Select the option by typing the 

firs t  letter until  the cursor highlights the option you want, then 

press < Return > . 

Using the Keyboard 

You can perform special functions with certain keys on the 

keyboard .  Each of these keys is designated by the name of the 

key surrounded by brackets ( < > ) . Some key names are ab­

breviated,  such as < ESC > for the Escape key and < BKS P  > for 

the B ackspace key. 

The following keys perform the functions described below: 

1-14 

< Return > 

S elect highlighted commands or options on the menu 

line, fields in the displays, and objects in the Draw 

graphics area .  Complete some actions . 

< BKSP > 

Undo the last action. Erase text to the left of  the cur­

sor ,  one character at a time. 

< ES C > 

Ret u r n  to  a m e n u  on e l evel  ahove t h e  cu r r e n t  m e n u. 
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Leave the online Help system. 

Complete some actions in the graphics area .  

<!> 

Perform a Shell Escape to  leave SCO ImageBuilder tem­

porarily and return to  the operating system.  (Type 

"exit" and press <Return> to  reenter the program . )  

<?> 

Get Help on any highlighted command or  opt ion .  

< Space Ba r> 

Interrupt redrawing of the graphics area .  Erase a value 

or  label in the Data display. 

< Arrow Keys> 

M ove the cursor to a command on the menu line, to a 

fie ld in a display, or to a location in the D raw graphics 

area .  

< Right> 

M ove the cursor to  the right. 

<Left> 

M ove the cursor to the left .  

<Up> 

M ove the cursor up. 

< Down> 

M ove the cursor down. 

1-15 
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< Arrow Keys > 

M ove the cursor very small steps in the Draw graphics 

area .  

< PGUP > 

Move the cursor diagonally (up and right) in the Draw 

graphics area .  Go to  the previous page of Help .  S croll 

up some lis t s .  

< PGDN > 

Move the cursor diagonally (down and right) in the 

Draw graphics area .  Go to the next page of Help .  

S croll  down some lists .  

< Home > � 
Move the cursor diagonally (up and left) in the Draw 

graphics area.  Go to the first command, option, or  

field in a display or l is t .  

< End > 

M ove the cursor diagonally (down and left)  in the 

Draw graphics area.  Go to  the last command, option or 

field in a display or l ist .  

< Numeric Pad 5 > 

Center the cursor in the Draw graphics area .  



Introduction 

[Fl] (HELP) 

Get  Help on any command or option on  the menu line,  

or  on fields in the displays . 

< F2 > (MOUSE) 

Turn on a mouse or tablet  attached to  your computer .  

Turn off the mouse or tablet .  

< F3  > ( INSERT) 

Insert  a value or label in a data se t .  

< F4 > ( DELETE) 

D elete a value or label in the Data display to  shorten a 

data se t .  Delete a text character as you enter text . 

< FS > (AUTOMATIC REDRAW) 

Automatically redraw the screen each t ime you modify 

an obj ect in the Draw graphics area .  Turn off the 

automatic redraw function. 

< F6 > (PREVIEW) 

Preview picture or chart file l isted in the 

M akeSlide or File displays . 

< F9 >  (REDRAW) 

Redraw the screen.  

< FlO > (QUICK EXIT) 

If you entered SCO ImageBuilder from SCO Profes ­

s ional, immediately exit SCO ImageB uilder and re turn 

to  SCO Professional .  
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Using a Mouse or Tablet 

A mouse or tablet makes SCO ImageBuilder even easier to use .  

You can move the cursor  around the screen rapidly. S imply slide 

the hand device across a smooth surface, in any direction. 

If  you have a mouse or tablet attached to your computer,  i t  is 

automatically activated.  Press the < F2 > key if you want to  turn 

off the device .  (Press < F2 > again to turn the device on.)  

On a mouse or tablet ,  button functions are the following : 

- 1st  button < Return > 

- 2nd button < ESC > 

- 3rd button < Undo > 

- 4th button < Redraw > 

Getting Help 

You can get help on any command, option,  or field in a display 

the cursor touches by pressing < F1 > . The program displays a 

screen containing useful information on the item your cursor cur­

rently touches .  The page number of each Help screen appears in 

the upper right corner of the screen. The following keys are ac­

tive in Help :  
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• < PGDN > 

• < PGUP > 

• < ES C > 

• < Fl >  

Introduction 

Go to the next screen.  

Return to  the previous screen.  

Return to your place in the program. 

Get  Help on general topics .  (To 

select  a general topic :  move the 

cursor bar to  the topic of your 

choice, and press < Return > . ) 
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Tutorial 

SCO ImageBuilder TUTORIAL 

Take this short  tutorial before you need to  give a presentation or 

create i l lustrations for a report .  To gain an understanding of  the 

program's continuity, we recommend you do the tutorial  in a 

s ingle sess ion .  I t  takes about one hour .  You will learn to :  

• Create a t ext chart .  

• Create a bar chart from your data .  

• Enhance a chart with additional text and graphics . 

• S end your images to a slide service for processing 

as 35mm sl ides .  

Before You Begin .. 

To do the tutorial ,  you'll need a graphics terminal .  A graphics 

printer or  plotter to  produce output is optional .  (To set up the 

program with your output device, refer to the output variable in­

formation in the Release and Installation Notes, or contact your 

system administrator . ) 

To start  the program: type Image at the prompt,  and press  

< Return > .  

The four tu torial exercises that follow are to he t aken together . 

One  exercise builds upon another.  Each takes about 15 minutes .  
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I t's a good idea to skim the information contained in Part One: 

In troduction before you take the tutorial .  That way, you'll have 

the necessary background to move rapidly through the exercises .  

By  the time you complete the tutorial ,  you'll be  ready to  begin 

creating graphics for professional use .  

Commands you are asked to  select ,  or information you type into 

the program are described in boldf�ce text . 

To Select a Menu Command 

Move the cursor along the menu line (with the < Right > and 

< Left > arrow keys or a mouse) to  the command of  your choice, 

and press the < Return > key. Alternatively, press the first  let­

ter key of the command. 

To Get Help 

Place the cursor over any command or display you don't under­

stand, and press < Fl > .  Useful information appears on the 

screen.  Press  < ES C > to  return to your place in the program. 

EXERCISE 1: Creating a Text Chart 

We'll begin by creating a text chart ,  a graphic image composed 

mostly of words .  When you are finished with this  exercise,  your 

screen will resemble Figure 2 -1 ,  although some variation i s  pos­

sible, due to  hardware differences .  

Before entering your text, you'll s e t  the  text options (drawing 

characterist ics)  that will determine how your text looks .  
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Tutorial 

Draw Version 1.8 
Create Hodify Erase Transfer Print Zool'l AddChart Quit 

Get, save, or delete a picture 

Figure 2-1 A text chart 

1. Move the cursor to the Draw command ( if  it is not al ­

ready there ) .  Press < Return > to select  Draw. The 

Draw graphics area appears. This is where your picture 

will be drawn on the screen .  Press < Return > again to 

select  Create. 

2. Se lect Options, followed by Text. 

3. Se lect Font, followed by Bold. (Fonts are let tering 

styles.) 

4. Select Height, followed by 7. 

5. Select Justify ,  followed by Left. 

6. Select  Quit to return to the Options menu, fol lowed by 

< ES C > to return to the Create menu. 
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Now you can enter your text,  beginning with the t i t le of your t ext 

char t .  

1 .  S elect  Text. (Notice that the text options you just set ap­

pear in the screen sidebar on the right side of the screen). 

The t ext cursor appears in the graphics area .  

2 .  Move the cursor with the < Up >  and < Left > arrow 

keys to  a location in the upper left corner o f  the 

graphics area,  where you want the firs t  le t ter  of your 

title to  appear .  Press < Return > .  The cursor appears 

on the menu line.  

3 .  Type Agenda.  (If you make a mistake while typing, press 

the <BKSP> key to erase text one character at a time.) 

Press  < Return > to see the text writ ten in the graphics 

area .  

Now, you wil l  learn how to  change options while in the middle of 

creating text .  

2-4 

4. Press  < ES C > to put the cursor back in the graphics 

area. Type "o "  to  select t ext options automatically. 

5. Select  Height, followed by 6 .  Press < ES C > to return 

t o  creat ing your text . 

6 .  Press  the < Right > arrow key one time to indent the 

next l ine of text .  Press < Return > .  The cursor ap­

pears  on the menu line. 
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7 . Type • New Product, and press  < Return > .  (The dash 

provides a bullet marker that defines the l ine as a 

separate unit of text . )  

8 .  Type • Dem onstrati on, and press  < Return > .  

9 .  Type • Questions ,  and press < Return > . 

Now, le t's add a ruling bar to give your t ext chart a more finished 

appearance . 

1 .  Press  < ES C > two times to return to the Create menu, 

then select Box. 

2 .  Type "o"  to select box options . 

3 .  S elect  Pattern . Pattern names appear on the menu l ine .  

Move the cursor over the arrow at the end of the l ine  to  

v iew a l l  the patterns .  Select MedSiant .  Press  < ES C > 

to  continue creating a box. 

4 .  Move the cursor against the left edge of the graphics 

area (about 1"  below your t ext ) ,  and press  < Return > .  

5 .  Press  and hold the < Shift > key while you press  the 

< Down > arrow key eight times .  (Notice that pressing 

the <Shift> key along with the arrow key allows you to 

move the cursor in much smaller steps.) 
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6 .  Press  and hold the < Right > arrow key to draw the box 

across the screen until i t  stops against the right edge of 

the graphics area.  

7 .- Press  < Return > to complete the box. (If, for some 

reason,  you don't l ike the ruling bar you jus t  created,  

you can press < BKSP > to undo the box and begin 

again by going back to Step 4 .)  

Company init ials  (or a logo) add a final touch to  a text char t .  This 

t ime, we'll use a short-cut method of selecting t ext options . 
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1 .  Press  < ES C > to return to the Create menu.  Type "o "  

to se lec t  Options .  

2 .  S elect Text. 

3. Type "r' to  select Font .  Type "c" to select Class ic .  

4.  Type "h" to  se lect  Height .  Type "7" to se lect  a new 

height .  

5 .  Type "j" to  select Justify. Type "r "  to  se lect  Right .  

Press  < ES C > twice . Type " t "  to select Text.  (Notice 

that the text options in the screen sidebar have changed 

to reflect the selections you just made.) 

6 .  Move the cursor to a location about 1" from the right 

edge of the graphics area and about 1/4" from the bot- � 
tom edge of the graphics area .  (Remember that you 
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can press  and hold the < Shift > key while pressing the 

arrow keys to  position the cursor more precisely .)  

7 .  Press  < Return > to select this location.  (Since your 

text is right-j ustified, the last letter of  text will  appear 

at the location you just  selected . )  

8 .  Type S C O, or your  company's name,  and press  

< Return > . 

Your t ext chart i s  complete .  Now you can save it with the File 

command. 

1 .  Press  < ES C > three times to  return to  the Draw menu.  

� S elect File .  The File display appears .  

2 .  Select  Save. Press < Return > to  select  the NewFlle  

box, so  that you can save your t ext chart  under a new 

name . 

3 .  Type Agenda, and press < Return > .  Press  < ES C > .  

Your screen should now look somewhat like F igure l-1, 

although some variation is possible,  due to hardware dif­

ferences .  

Now you can turn your text chart into printed or  plotted 

hardcopy, if  you have an output device attached to  your com­

puter .  (For instructions on set t ing up SCO ImageBuilder with 

your output device, refer to the output variable information in the 

Release and Installation Notes that came with the SCO Image­

B uilder manual,  or contact your system administrator . )  
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If you don't have an output device currently set  up, you can still  

see what your text chart will  look like as output in the following 

s teps .  

1 .  S elect  Print.  

2 .  Do one of the following: 

I f  you have an output device set up:  select Output .  

When your text  chart is done printing, press  < Space 

Bar > to  s top the screen from redrawing. 

If  you don't have an output device,  select Preview. 

When you are done previewing, press < ES C > and then 

< Space Bar > to stop the screen from redrawing. ·� 

EXERCISE 2: Creating a Data Chart 

Now you'll learn to create data chart s .  With SCO lmageBuilder,  

you can create several types of charts  from your data .  
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1 .  Press  < ES C > to reach the main menu. S elect  Chart .  

The Chart graphics area appears .  This  is where your 

chart wil l  be drawn on the screen.  But firs t ,  you must  

enter data for  the char t .  Data consists of values  and 

labels . 

2 .  Select Data.  The Data display appears .  
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3 .  S elect  Calendar. (Monthly labels automatically appear 

in the label column on the left side of the  display.)  

4 .  Select  DataEntry. The cursor appears in the firs t  value 

location.  

B efore  entering data, let's take brief tour of  the SCO Image­

B uilder Help system.  (You can get Help on any command, op­

tion,  or  display the cursor touches . )  

1 .  Press  < Fl > to get  Help on the Data  display. 

2 .  Press < Fl > again to reach the program's General Help 

Topics . 

3 .  M ove the cursor with the < Down > arrow key t o  any 

topic,  and press < Return > . 

4.  Press  < ES C > to  return to  your place in the program. 

Now, you can enter your data into the Data display.  

1 .  Press the < Up >  arrow key. Type West .  (If  you make a 

mistake,  press < BKS P > to  erase t ext characters . )  

2 .  Press  the < Right > arrow key. Type East .  

3 .  M ove the cursor to  the  firs t  space below West .  (If you 

m is-en tered "West" or "East, " simply move th e cursor to 

the m istake and retype the correct en try.) Type the fol-
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l owing numbers, pressing < Return > after each one: 

10 5 30. 

4 .  Move the cursor to the first space below East. Type the 

following numbers, pressing < Return > after each one: 

15 10 35. Press < ESC > .  Your screen should now 

look l ike Figure 2-2. 

5. Press < ES C > once more to see your data displaye d  as 

a vertical bar chart. 

Figure 2-2 The Data Display 

Now, let's simplify the Y axts (the vertical axis) to clarify the 

chart . First, you'l l  rescale the axis, then you'll simplify the axis 

labels. Finally, you'll p lace a legend on the chart . 

1. S elect Layout. 

2. S elect YAxis, followed by Scale. 
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3 .  Respond to  prompts asking you to  enter new Y axis 

values  by typing the following numbers ,  press ing 

< Return > after each one :  

0 40 20 .  

4 .  Select Precis ion,  followed by  NoDecimal s .  Press  

< ES C > to  see your simplified Y axis .  

5 .  S elect  Legend, followed by Legendlnside .  

Although SCO ImageB uilder's default (preset )  chart type is  the 

vertical bar ,  you can display your data as one of several  chart 

types ,  depending on the message you want to  convey. For ex­

ample, a pie  chart shows values as percentages of a whole .  Let ' s  

� see  what some of your data looks like as a pie chart .  

1 .  Press  < ES C > to  return to the Chart  menu.  S elect 

ChartType ,  followed by Pie. Since a pie chart shows 

only one data set (column of values in the Data dis­

play) , you will  now select the name of a data se t  t o  plo t  

as a p ie  char t .  

2 .  S elect East .  The East  data  is drawn as a pie chart .  

Press  < ES C > .  Now, let's emphasize one o f  the pie 

slices by " exploding" (separating) i t  from the whole pie .  

3 .  S elect Options,  followed by Explode .  

4.  Select  Feb, as the s l i ce to explode,  followed by Expl ode­

On.  Press  <ES C > to see the exploded pie slice . Now 

let 's  return to the vertical bar char t .  
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5. Select ChartType, followed by Vertlca iBar .  Your verti­

cal bar chart is redrawn. Press < ES C > . 

Next, you can add titles to identify the contents of your chart. 

1 .  Select Layout, followed by Titles . 

2 .  Select M a in, followed by Enter. 

3. Type Sales Are Up. (Press < BKS P  > if you make a mis­
take while typing.) Press < Return > .  

Now, let's enter a second title before seeing your title drawn on 

the screen. 

1 .  Press < ES C > to return to the Titles menu. Select 

YAxls,  followed by Enter. 

2 .  Type In M il l ions ,  and press < Return > . Press < ESC > 

two times to see your titles. 

EXERCISE 3: Enhancing Your Chart 

Now you can transform your chart into a graphic image that 

really gets your message across. SCO ImageBuilder lets you add 

text and graphics to data charts in the Draw menu. Your screen 

will look somewhat like Figure l-3 when you are done, depending 
on the type of display you have. 
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First ,  let's change the color palette and put  a background color 

into the D raw graphics area. 

Figure 2-3 An enhanced chart 

1. Press < ESC > two times to reach the main menu. 

S elect Draw, followed by Erase. S elect ClearPicture to 

erase the graphics area. ( Your text chart has already 

been saved in the file ,  so it's all right to erase it  now.) 

2. Press < ESC > to return to the main menu.  S elect 

Palette. The Palette menu appears .  

3. S elect Get. (The colors of the current palette appear at 

the bottom of a color display. Color names are listed if 

you have a black-and-white display.) Move the cursor 

(with the arrow keys) to several palette names, until  

you see  one you like.  Press < Return > to make that 
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palette the current one. 

4. Press < ES C > to return to the main menu. Select Back· 

ground,  followed by S olid.  The colors of the current 

palette appear on the menu line. Move the cursor over 

the arrow at the end of the line to view all 16 colors. 

5. Select a dark, neutral col or. The background color is 

listed in the screen sidebar. 

Now you're ready to add your bar chart to the Draw graphics area 

for enhancement. 

1. Select Draw. 

2 .  Select AddChart. 

3 .  Select Add. 

(A chart is added to the Draw graphics area as a whole unit called 
a symbol, so you can scale or move it. If you were going to modify 

its individual graphic elements-- change the color of a set of bars, 

for example -- you would have to undo the symbol. For the pur­

pose of this tutorial, you will let the chart remain a symbol.) 

Now let's add a large arrow to call attention to the point you in­

tend to make. You'll learn cursor keys that move the cursor 

diagonally. 
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1 .  Press < ES C > to return to the Draw nienu. Select 
Create . 
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1� 2 .  Select Polygon.  Type "o"  to select polygon options. 

3 .  Type "b"  to select BorderColor .  Select a light color like 

yellow. Type " i "  to select InteriorColor, and select the 

same light color. 

4 .  Type "p"  to select Pattern, followed by s to select Solid. 

Press < ES C > to continue entering your polygon. 

Now, you're ready to draw the arrow. 

1 .  Press < Shift > ,  then the < 5 > key (on your keyboard's 
number pad) to center the cursor in the graphics area. 

(If you m ake a mistake wh ile drawing th is arrow, you can 

press < BKSP > to undo it, point by point. ) 

2. Press the < Up >  arrow key two times, then < Return > .  

3 .  Press < PGDN > two times, then < Return > .  

4 .  Press < End > two times, then < Return > .  

5 .  Press the < Up >  arrow key one time, then < Return > .  

6. Press the < Left > arrow key two times, then 

< Return > .  

7 .  Press the < Up >  arrow key two times, then < Return > .  
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8 .  Press the < Right > arrow key two times, then 

< Return > .  

9 .  Press < ES C > to complete the polygon. (Notice that 

SCO lmageBuilder automatically completes your 

polygon, for greater drawing precision.) 

Now, you can modify the arrow. (If you wish to redraw the pic­

ture after each modification, press < F5 > to activate the 

automatic redraw feature. Then press < ES C > to continue.) 
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1 .  Press < ES C > two more times to return to the Draw 

menu. Select Modify, followed by Scale .  

2 .  Move the cursor to the outer edge of the arrow, and � 
press < Return > .  A box appears around the arrow. (If 

you selected another object by mistake, press < BKSP > 

to undo your selection and reselect the arrow.) 

3 .  Press and hold the < Shift > key while pressing the 
< Right > arrow key five times to scale the arrow 

smaller. Press < Return > . 

4 .  Press < ES C > to return to the Modify menu. Select 
Rotate . Move the cursor to the outer edge of the arrow, 

and press < Return > .  Press the < Right > arrow key 

to rotate the arrow to point toward the lower right of 

the graphics area. Then press < Return > .  

5 .  Press < ES C > ,  and select Move. Move the cursor to the 
o uter edge of the arrow, and press < Return > .  Use the 
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< Up >  and < Right > arrow keys to move the cursor to 

a location that will allow the arrow to point directly at 
the bar cluster labeled "Mar." Press < Return > to 

move the arrow. 

6 .  Press < ES C > two times to return to the Draw menu. 

Finally, you can add a line of text explaining the sales increase 

represented by the bars labeled "Mar." 

1 .  Select Create, followed by Text. Type " o" to select text 

options. 

2 .  Type "f'' to select Font, then select ItallcLlght. Type 

"h" to select Height, then Type "4." (Text justification 

should still be set at Right. If it is not, set that option 

now.) Press < ES C > to continue creating text. 

3 .  Move the text cursor about 1/8" to the left of the arrow, 

and press < Return > .  Since your text is right-justified, 

the last letter will appear at the location you just 

selected. 

4 .  Type Arter ad campaign. (If you make a mistake, press 

<BKSP > to delete text characters.) Press < Return > 

to see the text appear on the chart. 

Your enhanced data chart is now ready to save. 

1 .  Press < ES C > three times to reach the Draw menu. 

Type " f'' to select File .  Type " s "  to select Save .  Press 
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< Return > t o  select the NewFile box to  s ave your chart 

under a new name . 

2. Type Sales ,  and press < Return > to  save the enhanced 

version of your chart in the Draw file .  Press < ES C > 

two times to  return to the main menu. 

EXERCISE 4: Making 35mm Sl ides 

Now that you've created both a text and a data chart, you can easi­

ly t ransmit them to  the MAGICorp sl ide service for expert  

process ing as high- quality 35mm sl ides or transparencies .  For 

the purposes of this tutorial ,  you wil l  proceed up to  the point of  

sending your images  to  MAGICorp. 

Let 's prepare your images for a hypothetical transmission to 

MAGI Corp.  
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1 .  S elect MakeSi ide .  The MakeSlide display appears . 

2 .  S elect Sl ideList .  

3 .  S elect Add.  The cursor appears on the firs t  picture file ,  

Agenda , l i s ted on the left s ide  of the display. Press  

< Return > to  add Agenda t o  the S l ide  Lis t  on  the right 

side of the display. (The Slide List is  a l ist  of images 

you assemble to  send to MAGICorp . )  

4 .  Press  the < Down > arrow key, then press  < Return > to  

add Sales t o  the  S l ide Lis t .  Your screen should  now 

look l ike  Figure 2 - 4 .  (Notice that  Sales is l i s ted  as a 
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MakeS J i dc/S i ideL i st/Add Vers ion 1 . B  

Figure 2-4 The MakeSlide display 

picture file, rather than a chart fil e .  When you enhance 

a chart in the Draw graphics area, it  becomes a picture 

file . )  

Next , you will enter important customer order  information.  

1. Press < ESC > two times to return to the MakeSlide 

menu.  Se lect OrderForm, followed by C ustomer.  A 

customer order form appears on the screen. 

2. Type the correct information for each empty fie ld  in the 

form, and press < Return > . 

(The first field,  Site code, is for your customer identification 

code.  I f  you don't  already have a MAGICorp si te  code,  call 

1-800-FOR-MAGI (1-800-367-6244) now to obtain a code . )  
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3 .  After you have entered information in all the fieh 

the form, press < ESC > to return to the Order Form 
menu. The program saves the customer information 

you just entered, so you may never have to enter it 

again. 

Now, you can specify the media you want to order. 
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1. Select Media. A media order information form appears 

on the screen. The cursor appears in the first field, 
Number of slides. 

2 .  Type "2" in the Number of slides field, and press 

< Return > . This entry tells SCO ImageBuilder that 

you want to order two slides of each item in the Slide 

List. Notice that the Total box to the right of the field 

now lists "4." This means you've ordered two slides of 

the text chart and two slides of the bar chart, for a total 

of four slides. 

3 .  Move the cursor with the < Down > arrow key to the 

Slide mounting field. (Since you are ordering slides and 

no other media, the Slide mounting field is the only 

other field in the form you'll need to address.) The cur­
sor highlights the currently selected choice. 

4 .  Move the cursor to the Wess  choice. Let's assume for a 

moment that you aren't familiar with slide-making and 

don't know what Wess mounting is. 

5 .  P r e s s  < Fl > to acce s s  the program 's Help syst e m .  A 

description of the Wess  mounting appears on the screen. 
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,..... 6 .  Press < ES C > to return to your place in the program. 

. � 

NOTE: As you work with the program in the future, remember 

that you can get Help on any MakeSlide order form field you 
don't understand by pressing < Fl > . 

Finally, you'll enter some presentation order information. 

1 .  Press < ES C > to return to the Order Form menu. 

Select Presentation . The presentation order form ap­

pears on the screen, with the cursor in the Priority field. 

2 .  Move the cursor to the Normal choice (if it's not already 

there). You are telling MAGICorp that you want nor­

mal priority processing (two-day turnaround) . 

3. Move the cursor with the < Down > arrow key to the 

Presentation name field. Type Tutorial, and press 

< Return > . Press < ESC > to return to the Order­

Form menu. 

Now that you have prepared your images for processing as 35mm 

slides, you'll see how simple it is to transmit them to MAGICorp. 

1 .  Select Send.  A summary of your order appears on the 

screen for your verification. 

2 .  For the purposes of this tutorial, select No.  Normally, 

you would select Yes to transmit the images in the Slide 

List to MAGICorp for processing. 

You have just completed the tutorial. 
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To continue working with the program 

Press < ES C > two times to return to the SCO ImageBuilder main 
menu. 

To exit the program 
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1 .  Press < ESC > ,  followed by < Space Bar > to stop the 
screen from redrawing. 

2 .  Select Quit .  You receive a warning message telling you 

that the current chart is not saved. Since there is no 
need to preserve the unenhanced bar chart still in the 

Chart graphics area, press < ESC > to continue your 

exit. 

3 .  Select Quit,  and then press < Return > to select Quit· 

Program.  
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Command Reference · Malo Menu 

Main Menu Commands 

DRAW 

Draw allows you to create and edit pictures. Pictures are com­

posed of objects you draw on the screen. You can create text 
charts, organization charts, diagrams, and free- form drawings 

with the Draw command. 

CHART 

Chart allows you to create and edit data charts. First, you enter 
� your data into the program. Then, you choose a chart type to rep­

resent your data. You can create line, bar, area, pie, scatter, or 

mixed charts with the Chart command. 

BACKGROUND 

Background allows you to give a picture or chart a solid back­

ground, or to create a gradated background. 

PALETTE 

Palette allows you to create, change, and manage color palettes. 

A color palette is a collection of 16 colors. 
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MAKESLIDE 

MakeSlide allows you to  transmit picture and chart files  to  the 

MAGieorp slide service for processing as high-quality 35mm 

slides,  transparencies,  color prints,  or black & white copies . 

QUIT or RETURNTOPRO 

Quit  allows you to exit sea ImageBuilder and return to either 

the operating system or sea Professional ,  depending on the 

location from which you entered the program. 
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Drawing Commands 

Draw 

Draw allows you to  create a picture in the Draw graphics area. 

The graphics area is a blank area on the screen for drawing pic­

tures .  

Create a text chart ,  design an organization chart or  logo for your 

company, draw a diagram, or doodle a free-form drawing with the 

Draw menu.  You can add pre-drawn clip art  from the program's 

symbol l ibrary to  your images .  You can also combine pictures 

and enhance data charts  in the Draw graphics area .  

A picture may contain the following elements 

B ackground color 

Text 

Lines 

B oxes 

Circles 

Polygons 

Symbols 

D raw functions are performed on the current picture in  the 

graphics  area,  which appears when Draw is se lected .  
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The current picture may be an empty graphics area, a newly­

created picture, or a picture you retrieve with the Draw File com­

mand, Get. 

Figure 3·1  shows some sample" pictures. 
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R. Lee 
M. Rand 

S. Marlo 
I. Lazzo 
D. Ryan 

B. Brown 
K. O'Hara 

s c o � 
THE SANTA CRUZ OPERATION 

Figure 3-1 Sample pictures 
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� Select  Draw to  produce a picture by choosing from these i tems :  

• CREATE 

• MODIFY 

• ERASE 

• TRANSFER 

• PRINT 

• FILE 

• ZOOM 

Add new obj ects to  the current picture 

Edit the current picture 

Erase the current picture 

Transfer all or part of  a picture 

to  or from other programs 

Preview the current picture on the 

screen,  or produce final output  

Get ,  add,  save, or  delete picture files  

Magnify a port ion of the current 

picture for precision-drawing 

• ADDCHART Add the current chart t o  the picture 

• QUIT Return to the main menu 

CREATE 

Create  allows you to  draw obj ects in the graphics area ,  such as 

those shown in Figure 3 -l, and to change their opt ions .  S elect 

Create t o  choose from these menu items:  

• TEXT Add text to a picture 

• LINE Add l ines to  a picture  

• BOX Add boxes to a picture 
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• CIRCLE 

• POLYGON 

• OPTIONS 

• QUIT 

t e x t  

Boxes 

Add circles to a picture 

Add polygons to a picture 

Set default options for text,  l ines, 

or shapes 

Return to the Draw menu 

Lines 
Circles 

Figure 3-2 Pictures are composed of objects 
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Text 

Text allows you to  add text to a picture ,  or to  create a t ext char t .  

You can create  text of  various colors,  fonts ( let tering styles) , and 

heights .  You can align text on the page to  be  left -j ust ified ,  

centered,  or  right-j ustified .  (For t ips  on creating graphically 

good text charts ,  see the section "Building a B etter Text Chart"  

in Part One: Introduction, Presentation Graphics . )  

Text is  drawn on the screen in a draft mode (outline only) to  

speed  drawing time . Text appears in  final mode  ( filled- in) when 

you select Pr int to  preview a picture or print a picture on an out­

put device .  

To  create text :  

1 .  S elect Text. 

2 .  S elect a location for text . The cursor moves to the menu 

line for text entry. 

3. Type a line of text of up to  130 characters .  (If  you make 

a mistake, press < BKSP > to  delete characters t o  the 

left of  the cursor . )  

4 .  Press  < Return > to complete the text  l ine entry.  

5 .  Continue entering lines of text until  you are done . The 

second line of text appears directly below the firs t ,  and 

s o  on .  Press < ES C > t o  quit entering t ext . Press  
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< ESC > again to return to the Create menu. 

Text Options 

Text options (drawing characteristics) you can change include 

color,  font, height, and j ustification. 

To change default text options after you have selected Text, but 

before you select a location for text : 

1 .  Type "o . "  

2.  Select an option to change. 

3. S elect a variation of the option. 

4.  Press < ESC > or select Quit to make a new text entry. 

The next text you create changes to show the new op­

tion.  The option appears on the screen sidebar. 

NOTE: To change text options after you have completed a text 

entry, select :  Draw/Modify/Aiter/ObjectOptlons .  To change 

wording or spelling of existing text:  select 

Draw/Modify/Alter/Wording. 

Line 

Line allows you to add lines to a picture. You can create l ines of  

various colors, patterns, and thicknesses. You can draw lines 

with sharp corners or  smooth, rounded corners. You can even 

add arrowheads to lines. 
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To create lines :  

1 .  S elect  Line. 

2.  S elect a s tar ting location. 

3 .  Continue selecting points of a l ine (up to  250 points) . 

(To delete the line,  point by point ,  press < BKS P  > . 

Press  < ESC > to  end the line .  

4 .  Cont inue to  create  lines, or press  < ES C > t o  return t o  

t h e  Create menu. 

Line Options 

� Line options (drawing characteristics) you can change include 

color, pattern,  arrows, smoothing (on corners) , and width .  

To change default line options while creating lines :  

1 .  Type " o . "  

2.  S elect  an option to  change. Variations of  the  option ap·  

pear on the  menu line . 

3 .  S elect a variation. 

4.  Press  < ESC > or select Quit to  continue drawing the 

line .  The line you create changes to  show the new op­

t ion .  The option appears on the screen s idebar .  

NOTE: T o  ch ange l ine  option s of existing lin e s ,  select : 

Draw/Modify/ Alter/ObjectOptlons . 

3-9 



SCO ImageBullder User's Guide 

Box 

B ox allows you to add boxes to a picture .  You can create boxes 

of  various border colors,  inside colors,  and patterns.  

To create a box: 

1.  Select Box. 

2 .  Se lect a location for one corner of the box. 

3. S elect a location for the diagonal corner of the box.  (To 

delete this box, press < BKS P  > . To delete other b oxes 

you just  created,  continue pressing < BKSP > . ) 

Continue to  create boxes, or press < ESC > to return to  the 

Create menu.  

Box Options 

B ox options (drawing characteristics) you can change include 

border color, interior color, and pattern. 

To change default box options while creating boxes :  
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3 .  S elect a variation. 

4 .  Press < ESC > or select Quit to  continue drawing the 

box. The box you create changes to  show the new op­

tion. The option appears on the screen sidebar . 

NOTE: To change box options of existing boxes,  select :  

Draw/Modify/ AI ter/ObjectOptlons . 

Circle 

Circle allows you to  add circles to  a picture .  You can create 

circles of various border colors ,  inside colors ,  and patterns .  

To  create a circle :  

1.  S elect Circle .  

2 .  S elect  a location for the center of the circl e .  

3 .  S elect a location for the  radius of the  circle .  (To  delete 

this circle,  press < BKS P  > . To delete other circles you 

j ust  created,  continue pressing < B KS P > . )  

4 .  Continue to  create circles, or press < ES C > to  r eturn 

to  the Create menu. 

Circle Options 

Circle options (drawing characteristics) you can change include 

border color, interior color,  and pattern.  
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To change default circle options while creating circles :  

1 .  Type "o . "  

2.  S elect an option to  change . Variations of the opt ion ap­

pear on the menu l ine .  

3 .  S elect  a variation.  

4.  Press < ESC > or select Quit to  continue drawing the 

circle .  The circle you create changes to  show the new 

option.  The option appears on the screen sidebar . 

NOTE: To change circle options of existing circles,  select :  

Draw/Modify/ Alter/ObjectOptlons . 

Polygon 

P olygon allows you to  add polygons to a picture .  You can create 

polygons of various border colors ,  inside colors ,  and patterns . 

To  create  a polygon:  
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1 .  S elect Polygon .  

2 .  S elect a starting location. 

3 .  Continue to  select up to 250 points to  make a polygon .  

(To delete th i s  polygon, press < BKSP > .  To delete 

any other polygons you just  created,  cont i nue pressing 

< BKS P > . ) 
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4. Press  < ES C > to  complete the polygon.  

5 .  Continue to  create polygons, or press < ES C > to  r eturn 

t o  the Create menu. 

Polygon Options 

Polygon options (drawing characteristics) you can change in­

clude border color,  interior color, and pattern.  

To change default polygon options while cre ating polygons :  

1 .  Type "o . "  

2 .  S elect an opt ion to  change .  Variations of the opt ion ap­

pear on the menu line . 

3 .  S elect a variation.  

4 .  Press  < ES C > or select Quit to  continue drawing t he 

p olygon.  The polygon you create changes  t o  show the 

new option.  The option appears on the screen sidebar . 

NOTE: To change polygon options of existing polygons, select :  

Draw/Modify/ Alter/Obj ectOptions . 

Options 

Options allows you to  select default (preset)  drawing characteris­

t ics for obj ects you subsequently create .  You can change default 
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options at any time, even while in the midst of creating an object. 

Object options include: 

Text -- Color, font, height, justification 

Lines -- Color, pattern, arrows, smoothing, width 

Boxes -- Border color, interior color, pattern 

Circles --Border color, interior color, pattern 

Polygons -- Border color, interior color, pattern 

NOTE: To change the options of objects that already exist in the 
graphics area: select Draw/Modlfy/Aiter/ObjectOptlons . 

Select Options to choose from the following items: 

• TEXT 

• LINES 

• SHAPES 

• QUIT 

Text 

Change default text options 

Change default line options 

Change default box, circle, and polygon 

options 

Exit the Options menu and return to the 

Create menu 

Select Text to cho ose from these menu items: 

• COLO R Change default text color 

• FONT Change default text font (lettering style) 
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• HEIGHT Change default text height 

• JUSTIFY Change default text justification 

• Q UIT Return to the Options menu 

Options you set for text affect all text you subsequently create. 

You can change text options at any time with the Options com­
mand. (To change options while in the midst of creating text, 

simply type "o "  before selecting a location for text.) 

Text options appear on the screen sidebar whenever you create 

or modify text. 

NOTE: To change the options of text that already exists in the 

graphics area: select Draw/Modlfy/Alter/Obj ectOptions .  

Color 

Color allows you to change text color. There are 16 colors in the 

current color palette. 

To set the color: 

1 .  Select Color. 

2 .  Select a color choice. (Scroll the arrows at either end 

of the line to view all the color choices.) 

The color you set appears on the screen sidebar. 
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NOTE: To change color palettes or edit the colors of the current 

palette: select Palette from the main menu. 

Font 

Font allows you to change text font. Fonts are lettering styles, as 

shown in Figure 3 -3 .  It's best to use only one or two fonts in a 

graphic image. 

Fonts are drawn on the screen in a draft mode (outline only) to 
speed drawing time. Fonts appear in final mode (filled-in) when 
you select Print to preview a picture or print it to an output 

device. 
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italic bold 
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Figure 3·3 Font styles 
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You have six choices :  

• LIGHT Lightweight lettering (good for bullet  

points  on text charts and chart axis  t i t les)  

• B OLD Heavy lettering (excellent for main tit les) 

• CLASSIC Looks like schoolbook t ext (good for 

tit les and labels) 

• ITALICLIGHT Light, slanted let tering (good for 

fine labeling) 

• IT ALICBOLD Heavy, slanted lettering (good for 

emphasizing a point) 

• SCRIPT 

To se t  t ext font : 

1 .  Se lect Font .  

Cursive lettering ( lends an artist ic 

touch) 

2. S elect  a font style . 

The font  you set  appears on the screen sidebar .  

Height 

Height allows you to  change text size.  There are ten t ext heights ,  

ranging from small to  large . 
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Generally, text in the middle range (between 5 and 8) is the most 

visible and readable for projected visuals. Text for the printed 
page is legible at any size. The larger the text height, the less 

text you will be able to fit in the graphics area. 

To set text height: 

1. Select Height. 

2 .  Select a text size. 

The height you set appears on the screen sidebar. 

Justify 

Justify allows you to change text justification. Justification aligns 

your text on the page from a starting location you select, as il­

lustrated by Figure 3-4. 
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left-justified text 
.. 

centered text 
.. 

right- justified text 
.. 

Figure 3-4 Text justifications 
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There are three text justifications :  

• LEFT 

• CENTER 

• RIGHT 

B egin text at the starting location,  

writing from left to right 

Center text on the starting location 

End text at the starting location,  

writing from right to  left 

To  set  t ext justification:  

1 .  S elect Justify. 

2.  S elect a j ust ification. 

The j ust ification you set appears on the screen s idebar .  

Quit 

Select Quit when you have finished changing the options for text . 

Lines 

Se lect  Lines to  choose from these menu items : 

• COLOR Change default l ine  color 

• PATTERN Change default l ine pattern 

• ARROWS Change default l ine arrows 
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• SMOOTHING Change default line smoothing 

• WIDTH Change default line width 

• Q U IT Return to the Options men� 

Options you set for lines affect all lines you subsequently create. 

You can change line options at any time with the Options com­
mand. (If you are in the midst of c�eating a line, simply type "o "  

t o  change its options.) 

Line options appear on the screen sidebar whenever you create 

or modify lines. 

NOTE: To change the options of lines already in the graphics 

area, select Draw/Modlfy/Aiter/ObjectOptlons . � 

Color 

Color allows you to change line color. There are 16 colors in the 

current color palette. 

To set the color: 

1 .  Select C olor.  

2 .  Select a color choice. (Move the cursor over the arrows 

at either end of the line to view all the color choices.) 

The c o l o r  you s e l e c t  appears  on t h e  � e r e  en s i d ebar . 
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Pattern 

Pattern allows you to change line pattern.  Line patterns include :  

solid,  
·
long dash, medium dash, short dash, dotted,  dash-dot ,  

dash- double-dot ,  and double- dot .  

To set  l ine  pattern :  

1 .  S elect  Pattern . 

2. S elect a line pattern.  

The pattern you select appears on the screen sidebar .  

Arrows 

Arrows allows you to add arrows to a l ine, or t o  r emove arrows . 

• NOARROWS Removes arrows from lines 

• STARTARROW 

Gives l ines  an arrow at  the firs t  

l ine  point  you select 

• ENDARROW Gives l ines  an arrow at the last  

l ine point you select  

• BOTHARROWS 

G ives lin e s  arr ows at hoth  t h e  

first  and l a s t  l ine points  y o u  select  
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To se t  line arrows : 

1 .  S elect Arrows . 

2. S elect an arrow style .  

The arrows you set  appear on the  screen sidebar .  

Smoothing 

Smoothing allows you to  change a line to show smooth curves or  

sharp angles ,  as shown in Figure 3-5.  You can draw free -form 

I 
I 

stra ight l ine 

curved l ine 

Figure 3-5 Line smoothing 
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drawings more easily with smooth lines .  

You have two choices :  

• CURVEDLINE Draws lines as smooth curves 

• STRAIGHTLINE Draws lines as pointed angles 

To  set line smoothing: 

1 .  S elect S moothing.  

2 .  S elect S traightLine to draw a sharp l ine,  or  CurvedLine 

to  draw a smooth line. 

The smoothing you set  appears on the screen sidebar . 

NOTE: As you create a line, the program draws it with sharp 

corners .  If  you have set the CurvedLine option,  the l ine is 

redrawn with curved corners when you complet e  i t .  

Width 

Width allows you to  set  the width of a l ine .  There are six line 

widths,  r anging from narrow to  wide .  

To  set  l ine  width :  

1 .  Se lect Width.  
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2. S elect a width choice. 

The width you set  appears on the screen sidebar . 

Quit 

Select  Quit  when you have finished changing options for l ines .  

Shapes 

Select  S hapes to  change the colors and patterns of boxes ,  circles,  

and polygons by choosing from these menu items: 

• B ORDERCOLOR 

Change default frame color for shapes 

• INTERIORCOLOR 

Change default inside color for  shapes 

• PATTERN Change default pattern for shapes 

• QUIT Return to the Options menu 

Options you set  for shapes affect all shapes you subsequently 

create .  You can change shape options at any time with the Op­

tions command. (If  you are in the midst of creating a shape, simp­

ly type "o" t o  change i ts  options.)  
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Shape options appear on the screen sidebar whenever you create 

or  modify boxes ,  circles or polygons . 

NOTE: To change the options of shapes already in the gr aphics 

area :  select  Draw/Modlfy/Alter/ObjectOptlons .  

BorderColor 

B orderColor allows you to  set the default outl ine color for boxes ,  

c ircles  and polygons.  

To set  border color :  

1 .  S elect BorderColor. The 16 colors of  the current 

palette appear on the menu line .  (Move the cursor  over 

the arrows at either end of the menu line to  view all the 

color choices . )  

2 .  S elect a color choice . 

The border color you set appears on the screen sidebar.  

(To change the palette :  select Palette from the main menu.) 

lnteriorColor 

InteriorColor allows you to  set the default ins ide color for  boxes,  

circles and polygons . 
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To set  interior color : 

1 .  S elect lnterlorColor. The 16 colors of the current 

palette appear on the menu line . (Move the cursor over 

the arrows at either end of the menu line to  view all the 

color choices . )  

2 .  S elect a co lor  choice . 

The interior color you set appears on the screen sidebar .  

NOTE: If  the  pat tern of a shape is hollow, the  interior color  will 

not appear . 

(To change the palette :  select Palette from the main menu.)  

Pattern 

Pattern allows you to set the default pattern for boxes, circles ,  

and polygons . Patterns fill in the interior areas of shapes,  creat­

ing diversity among objects .  

Patterns for shapes include:  hollow, sol id,  wide slant,  medium 

slant,  narrow slant,  wide hatch, medium hatch, narrow hatch, ver­

tical line and horizontal line . Finer patterns (such as narrow 

hatch) add texture to a color, toning it down to resemble a gray 

scale .  

Patterns other t h a n  h ollow and solid do not  appear on 35mm � 
slides or transparencies .  In addition, some displays and output 
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devices may not  have the capability to  display all the pattern 

choices .  

To set  shape pattern:  

1 .  Select Pattern. (S croll the patterns that appear on the 

menu line by moving the cursor over the arrows at 

either end of the line . )  

2 .  S elect a pattern style . 

The pattern you set  appears on the screen sidebar .  

NOTE: Patterned obj ects (except solid) are " t ransparent , "  in the 

sense that you can see through them to  any obj ects that may be in 

back of  them. 

Quit 

S elect Quit when you have finished changing the options for 

boxes,  circles and polygons.  

Quit 

Select  Quit  to  exit the Options menu and return t o  the Create 

menu . 

. � Quit 

S elect  Quit  to  exit  the Create menu and return to  the Draw menu.  
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MODIFY 

Modify allows you to change obj ects in the graphics area .  After  

you modify obj ects ,  you may want to redraw the screen with the 

< F9 > key,  if  the automatic redraw function is off. 

Select Modify to choose from these items : 

• ALTER Change options for existing obj ects ,  or 

change wording of existing text 

• COPY Copy an obj ect 

• ROTATE Rotate an obj ect to  a different angle 

• MOVE Move an obj ect to another location 

• SCALE Make an obj ect larger or smaller 

• WARP S tretch or shrink an  obj ect t o  different 

proportions 

• D ELETE Erase an obj ect from the graphics area 

• GROUP Group objects in to  a symbol,  or  undo a 

symbol 

• ORDER Order overlapping obj ects to  the front or  

the  back 

• QUIT Return to  the Draw menu 
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• create 
an object 

copy 

warp 

scale and rotate 

National  Egg , In c .  

Figure 3-6 Modifying an object to create a drawing 

3-29 



SCO lmageBullder User's Guide 

You may use the Modify commands to  add finishing touches to  a 

picture, or  to  produce particular effects as you create a picture .  

For example, you might perform the following tasks  to  create the 

effects  shown in Figure 3-6:  

Copy an obj ect .  (Modify/Copy) 

Group obj ects into a symbol .  (Group/InB ox) 

Warp the symbol .  (Warp) 

S cale the symbol larger .  (Scale) 

Undo the symbol .  (Group/Undo) 

Rotate one of the obj ects .  (Rotate) 

Make another copy of the obj ect . (Copy) 

Rotate and move the second copy. (Rotate and Move) 

NOTE: M odify is not selectable when the graphics area is  empty. 

To create a picture:  select Draw/Create. To retrieve a saved pic­

ture:  select Draw/Fi le/Get .  

Alter 

Alter allows you to change the options of individual obj ects  that 

already exist  in the graphics area. You can also edit the wording 
or spelling of existing text . Select Alter to  choose from these 

items : 

• OBJECTOPTIONS 

• WORDING 
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• QUIT Return to  the Modify menu 

ObjectOptions 

Obj ectOptions allows you to change the drawing characteristics 

of  obj ects that currently exist in the graphics area.  (You cannot 

change the options of a symbol until you undo the symbol  by 

selecting Group/Undo . )  

To change the options of an obj ect : 

1 .  S elect ObjectOptions .  

2 .  S elect an obj ect in the graphics area .  

3 .  Options for the obj ect appear on the menu l ine .  S elect  

an option.  Variations of the option appear on the menu 

line . 

4. S elect a variation. 

5.  S elect other options to  change for the obj ect ,  or  press  

< ES C > to  see the object redrawn with the new at­

tributes .  

6 .  S elect o ther  obj ects of the  same type for  the same 

change,  and press < ES C > .  

7 .  S elect another object for which to  change options ,  or  

press  < ES C > to  return to  the  Alter menu.  

(To change default options for objects ,  select  Draw/Create/Op· 

t ions . )  

3-31 



SCO lmageBullder User's Guide 

Wording 

Wordi�g allows you to  edit the wording or change the spelling of  

text that already exists  in the graphics area. 

To change wording or spelling: 

1. Select Wording. 

2.  S elect a line of  text in the graphics area.  The text ap­

pears on the menu line with the cursor after the last 

character .  

3 .  Press  < BKSP > to  erase text characters ,  one at a t ime.  

(You can position the cursor within the line of text 

using the < Home > ,  < End > , and arrow keys . )  

4.  Type new text on the  menu line, and press < Return > . 

The new text you type replaces the old text.  

5 .  S elect another line of text to  change, or press < ESC > 

to  return to  the Alter menu. 

{To change options (drawing characteristics) of text that already 

exists  in the graphics area: select Draw/Alter/Obj ect· 

Options/Text . )  
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Quit 

Select Quit to  exit the Alter menu and return t o  the Modify menu. 

Copy 

Copy allows you to  copy an object in the graphics area .  Copy can 

save you drawing time if your picture is composed of several 

similar objects .  You can copy an obj ect ,  then change options on 

one obj ect (Alter/Obj ectOptions) to  differentiate i t  from the 

copy. 

� To copy an obj ect to a new location: 

1 .  Select Copy. Move the cursor to  the outer edge of the 

obj ect you want to copy, and press < Return > .  A box 

surrounds the object .  

2 .  M ove the box to a location for the copy,  and press  

< Return > . (To delete  this  copy, press  < BKS P  > .  To 

delete other copies  you j ust made, continue pressing 

< BKS P > . ) 

3 .  M ake more copies of the same obj ect ,  or  press  < ES C > 

to  select another object to  copy. Press  < ES C > again 

to  return to  the Modify menu. 
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Rotate 

Rotate allows you to rotate an object to a different angle, in 

either direction.  When you select an object to rotate ,  a box ap­

pears around the obj ect,  and its angle of rotation (0 degrees) ap­

pears on the prompt line . First ,  you rotate the box to  a new angle .  

When you select t h e  new angle, the obj ect then rotates to  fit into 

the box again. 

The angle degrees on the prompt line can help you rotate the box 

more precisely. Full circle is 360 degrees .  Use the following 

degrees for reference points :  

- 0 degrees - - S tarting vertical 

- 180 degrees - - Reverse vertical 

- 90 degrees - - Counterclockwise horizontal 

- 270 degrees - - Clockwise horizontal 

To rotate an obj ect :  
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1 .  S elect Rotate. 

2 .  Move the cursor to  the outer edge of the obj ect you 

want to  rotate, and press < Return > . A box appears 

around the obj ect . 
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3 .  Use the cursor keys to move the box to  a new angle,  and 

press  < Return > .  (To undo the rotat ion,  press 

< BKS P > . ) 

4 .  S elect another obj ect to  rotate ,  or press < ES C > t o  

re turn to  t h e  Modify menu. 

Move 

M ove allows you to  move an obj ect to  a new location in the 

graphics area .  

To move an obj ect : 

� 1 .  S elect Move.  

2.  M ove the cursor to  the outer edge of the obj ect you 

want to move, and press < Return > . A box appears 

surrounding the obj ect .  

3 .  Use the cursor keys to  move the box to  a new locat ion,  

and press < Return > .  (To undo the move , press  

< B KS P > . )  

4 . S elect another obj ect to move, or press < ES C > to  

re turn to the Modify menu. 

Scale 

Scale a l l ows you to  m a k e  an  ohj e c t  l arger or s m a l l e r .  T h e  ohj ect 

you scale changes size,  but retains i t s  proport ions . 
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To scale an obj ect :  

1 .  S elect Scale .  

2 .  Move the cursor to the outer edge of the obj ect you 

want to  scale,  and press < Return > . A box appears sur­

rounding the obj ect .  

3 .  Move the cursor with the  ar�ow keys to increase or 

decrease the size of the box.  When it  is  the size you 

want,  press < Return > . . (To return the obj ect to  its 

former size, press < BKS P > . )  

4.  S elect another obj ect to scale, or press < ES C > to 

return to the Modify menu. 

Warp 

Warp allows you to  stretch or compress an object in one direc­

tion to  change i ts  proportions . For example, you can warp a 

circle to  form an ellipse (oval) shape.  You can warp obj ects and 

symbols ,  but not text or symbols that contain only text . 

To warp an obj ect :  
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1 .  Select Warp. 

2. Move the cursor to the outer edge of the obj ect you 

want to  warp, and press < Return > .  A box surrounds 

the obje.ct . 
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3 .  M ove the cursor to stretch or compress the box to  new 

proportions ,  and press < Return > .  The obj ect is  

redrawn to  the size and shape of the box. (To undo the 

warp, press < BKS P >  . )  

4 .  S elect  another obj ect to warp,  or press < ES C > to 

re turn  to the Modify menu.  

Delete 

D elete allows you to erase an object from the graphics area .  

To delete an obj ect :  

� 1 .  Select Delete .  

2 .  Move the cursor to the outer edge of the obj ect you 

want to  delete ,  and press < Return > . (To undo the 

delet ion,  press < BKS P  > . ) 

3 .  Continue selecting obj ects to  delete ,  or press  < ES C > 

t o  return  to  the Modify menu. 

Group 

A symbol  is a group of objects  you can modify as one unit . You 

can group several objects  into  a symbol in order t o  move or  scale 

them all  at  once .  Grouping objects in a box is  the fastest  method 

of  creat ing a symbol .  However, select ing individual obj ects  to  

form a symbol lets you modify objects  tha t  may no t  be easily 

grouped into a box. 
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S elect Group to  choose from these menu items:  

• INBOX 

• OBJECT 

• UND OSYMBOL 

• QUIT 

Group obj ects into a symbol by making a 

box around the obj ects the symbol will 

contain 

Group obj ects into a symbol  by selecting 

each obj ect the symbol will contain 

Ungroup the objects of a symbol 

Return to  the Modify menu 

NOTE: You cannot change the options of obj ects contained in 

a symbol until you undo the symbol by selecting Group/Undo .  ·� 

In Box 

InBox allows you to create a symbol by surrounding objects  you 

want to  include in the symbol with a box. 

To group obj ects in a box: 
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1 .  S elect  InBox.  

2.  S elect a starting point for the box.  

3 .  S elect a location for the diagonal corner of the box, so  

tha t  i t  completely contains the  obj ects you  want in the 

symbol .  (Press < BKS P >  to undo the box.)  
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� 4. Continue creating symbols,  or press < ES C > t o  return 

to  the Group menu. 

Object 

Obj ect allows you to create a symbol by selecting each obj ect the 

symbol will  contain.  You can group objects from any part  of  the 

graphics area into a single symbol .  

To  create a symbol by selecting objects :  

1 .  S elect Object .  

2 .  S elect the outer  edge of an obj ect you want to  include . 

(To remove this obj ect from the symbol ,  press  

< BKS P > . ) 

3 .  Continue selecting obj ects to  include in the symbol ,  or  

press  < ESC > to complete the  symbol .  (To undo the  

symbol ,  press  < BKSP > .) 

4. Continue creating symbols ,  or press < ES C > again to  

return to  the  Group menu. 

UndoSymbol 

UndoSymbol allows you to  ungroup a symbol into separate ob­

j ects ,  which you can then modify individually. 

To undo a symbol :  
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1 .  S elect UndoSymbol.  

2. Se lect a symbol to undo . (To reunite the symbol,  press 

< BKS P > . ) 

3 .  Continue selecting symbols to undo, or press < ES C > to  

return to  the  Group menu. 

Quit 

Select Quit to  exit  the Group menu and return to  the Modify 

menu.  

Order 

Order allows you to  rearrange the order of overlapping obj ects 

in the graphics area .  as shown in Figure 3·7 .  As you create and 

modify obj ects ,  you can use the Order command to  " layer"  ob­

j ects ,  one in front of another,  to  achieve a final order for your 

picture .  Select Order to choose from these items : 

• FRONT Pull an obj ect in front of all other obj ects 

• BACK Push an object behind all other obj ects 

• QUIT Return to  the Modify menu 

NOTE: If  obj ects in front have patterns other than solid, you will 

be able to see through them to those in the back. 
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Figure 3-7 Reordering objects 

Front 

Front allows you to pull  an obj ect from behind other obj ects t o  

t h e  front of  t h e  screen. 

To pull  an obj ect to the front:  

1.  S elect Front.  

2. Move the cursor to the outer edge of  the obj ect you 

want to pull  forward, and press < Return > .  The obj ect 

appears at the front of the screen. (To undo the reor­

der, press < BKS P >  . ) 
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3 .  Continue pulling obj ects forward, or press < ES C > to  

re turn to  the  Order  menu. 

Back 

Back allows you to  push an overlapping obj ect behind other ob­

j ects .  

To push an obj ect behind another :  

1 .  S elect Back. 

2 .  Move the cursor to  the outer edge of the obj ect you 

want to  push back, and press < Return > . (To undo the 

reorder, press < BKS P > . ) � 
3 .  Continue pushing objects back, or press < ES C > to  

return to  the Order  menu. 

Quit 

S elect Quit to  exit the Order menu and return to  the Modify 

menu.  

Quit 

Select Quit to  exit the Modify menu and return to  the Draw menu.  
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ERASE 

Erase allows you to  erase the current picture If the current pic­

ture is unsaved, you may want to save it  before you erase i t  per­

manently.  (An unsaved picture is one you have j us t  created or 

modified . )  Once you select Erase ,  you have two choices :  

• CANCEL Resume work in the Draw menu or save 

your picture with the File command 

• CLEARPICTURE 

Completely erase the current picture in the 

graphics area 

To erase the current  picture :  

1 .  Se lect Erase .  

2 .  S elect Cancel  to return to the  Draw menu without eras ­

ing ,  or  select ClearPicture to erase  the  picture .  

TRANSFER 

Transfer allows you to  import or export  a picture between SCO 

ImageBuilder and  other programs, via the  Clipboard .  (Contact 

your system administrator for more information on the Clip­

board . )  

Select  Transfer to  choose from these i tems :  

3-43 



SCO lmageBullder User's Guide 

• COPY Copy a l l  or par t  of a picture from the 

graphics area  to  the  Clipboard 

• PASTE Transfer a picture from the Clipboard to  

the  graphics area 

• REMOVE Erase a picture from the Clipboard 

• QUIT Return to the Draw menu 

Copy 

Copy allows you to  copy a picture (or a portion of a picture) to  

the  Clipboard by making a box  around the  obj ects you  want to  

copy. ·� 

To copy a picture to  the Clipboard:  
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1. S elect  Copy. 

2 .  S elect a location for one corner of the box. 

3. S elect a location for the diagonal corner of the box. 

4 .  Type in a description for the picture (of up to  14 charac­

ters) , and press < Return > .  A copy of the picture con­

tained in the box is transferred to  the Clipboard .  From 

there,  you can transfer the picture to other programs .  
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Paste 

Paste allows you to bring a picture from the Clipboard to paste 

into the graphics area . . 
The picture you paste is  added to  the cur­

rent picture .  

To pas te  a picture in the  graphics area :  

1 .  S elect Paste .  

2 .  S elect an item from the Clipboard to  paste .  The picture 

you select is  added to the current picture .  

Remove 

Remove allows you to  erase a picture from the Clipboard .  

To remove a picture :  

1 .  Select  Remove. 

2.  S elect the name of a picture to  remove . 

Quit 

S elect Quit  to  exit  the Transfer menu and return t o  the Draw 

menu.  
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PRINT 

S elect Print to preview the current picture on a full screen or 

produce finished output on a printer or plotter .  You have two 

choices :  

• PREVIEW 

• OUTPUT 

Preview 

View the current picture, enlarged t o  

full-screen size 

Produce final output 

Preview allows you to  see the current picture on a full screen, so 

that you can get a better idea of how the finished picture will look.  

To  preview the current picture :  

1 .  S elect Preview. 

2. Press  < Space Bar > to stop the preview. 

NOTE: I f  you have a color monitor that displays at least  32 
colors,  Preview allows you to view a gradated background. 

Output 

Output  al lows you to  pr oduce f inal output  on the p r i n t e r ,  plot ter  

or camera device . (For instructions on setting up SCO Image-
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� B uilder with your output device, refer to  the Release and Instal­

lation Notes that came with the manual, or contact your system 

administrator . ) 

To produce output :  

1 .  S elect Output .  

2 .  S elect the name of an output device . 

NOTE: You may continue working with SCO ImageBuilder while 

your output is  being produced. 

Quit 

Se lect  Quit  t o  exit  the Print  menu and return t o  the Draw menu.  

FILE 

File allows you to organize and manage your picture files .  You 

can get ,  save, or  delete picture files .  In addition, you can add a 

picture from the file to  the current picture or  change the current 

directory to  access picture files in other directories .  

Select  File  to  choose from these menu i tems :  

• GET 

• ADD 

Get a picture 

Add a p i c t u r e  from the fi l e  t o  the current  

picture 
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• SAVE Save the current picture 

• DELETE Erase a saved picture 

• CHANGED IR Change the current directory to 

access different picture files 

• QUIT Return to the Draw menu 

Draw/F i le/Get Vers ion 1.8 

Se lect a p icture t o  get 

Get 

Figure 3-8 Getting a picture file 

Get allows you to retrieve a picture file. Pictures in the file are 

shown in Figure 3-8. The picture you get replaces the current 

picture in the graphics area. The name of the picture  appears on 

the screen s idebar. 
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� S ince you are actually getting a copy of the picture file ,  you can 

make changes to  it and even erase it  from the graphics area 
without affecting the original picture .  

T h e  original version o f  your picture remains unaffected,  unless 

you delete it  from the file or replace i t  when you save the revised 

version .  

To get a picture :  

1 .  Select  Get. If the  current picture i s  unsaved, se lect one  

of the following: 

- S top Return to  the File menu 

- Continue Replace the current picture 

2 .  Se lect the name of a file to get .  (Press < PGDN > to 

scroll  the File Display if the file does not  appear on the 

screen. ) 
3 .  Press  < ES C > to  leave the File menu and see  the pic­

ture drawn in the graphics area.  

NOTE: When you get a picture, the palette that was saved with 

that picture becomes the current palet te .  
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Add 

UNIX Systems 
- Software applications 
- SoftCare support 

UNIX Systems 
- Software applications 

- - SoftCare support 
-

S C O E! 
THE SANTA CRUZ OPERATION 

Figure 3-9 Combining two pictures 

Add allows you to combine a picture file with the current picture .  

For example,  you might perform the following steps to  add your 

company logo to  the current picture, as shown in Figure 3·9 :  

Create a text  char t .  (Create/Text) 

� 
I 

Add a saved picture (the logo) to the text char t .  (File/Add) � 
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� To add a picture :  

1 .  S elect Add. 

2. Se lect the name of a picture to add. (Press < PGDN > 

to  scroll  the File Display, if the file does not  appear on 

the screen . )  

3 .  Press  < ESC > to leave the Fi le  menu and see  the pic­

ture added to  the current picture .  

NOTE: When you add a picture, the current picture ' s  palet te 

remains the current  pale t te .  

Save 

Save allows you to save the current picture to produce as output 

or revise later on .  

To save the current  picture :  

1 .  S elect Save.  

2 .  Do one of the following: 

- To save the picture under a new n am e  

Select NewFile , type a name, a n d  press  

< Return > .  
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- To save the picture by replacing a file 

Select the name of a file you want to  replace . 

Then, select Replace to replace the original 

file ,  or  Quit to return to the File menu.  

Delete 

Delete allows you to delete a picture file .  

To delete a picture fil e :  

1 .  Select Delete.  

2 .  Select a file name. (Press < PGDN > to  scroll  the File 

Display, if  the file does not appear on the screen . )  

ChangeDir 

ChangeDir allows you  to change the  current directory, in order 

to  get files from or save images into other directories .  

To change the current directory: 

1 .  Select ChangeDir. 

2 .  D o  one of the following: 

- If you see the name of the directory you want 
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Select the name. (The single dot ( . )  in the l ist  

of directory names is the current directory . 

The double dot ( . .  ) is the parent directory .)  

- If you do n ot see the name of the directory 

Select NewDirectory, then type the directory 

name, and pre ss < Return > . 

Drllwrl.uu..Vtt<'lgniry Vftr,.inn \ , ., 

se iict iOCAt lOt. of %.00... boJC, (iiJCSi>>res h:c, ([sc>l'le-nu . - - -- - -- -- -

Drawi'Zoof'l'l Uors lon 1 . 8  
ru I ISh:� Hagnity r .. n Quit 

Figure J-10 Zooming in on a portion of the picture 
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The name of the directory and the files it contains appear on the 

screen .  

Quit 

Select Quit  to  exit the File menu and return to  the Draw menu.  

ZOOM 

Zoom allows you to  zoom in on (magnify) a port ion of the picture 

in the graphics area,  in order to  see more detail  or  draw with 

greater precision.  Select Zoom to choose from these i tems :  

• FULLSIZE 

• MAGNIFY 

• PAN 

• QUIT 

Zoom out to  a full-size picture 

Zoom in to magnify a portion of  the 

picture to  the full size of the graphics area 

Move the zoomed area to  magnify a 

different portion of the picture 

Return to the Draw menu 

For example,  you might perform the following steps to  add fine 

detail  t o  a picture,  as shown in Figure 3·10 :  

Create a picture .  (Create) 

Zoom in on a portion of the picture to add fine detail .  

(Zoom/Magnify) 
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NOTE: In  some cases,  you may be able to  magnify a zoomed pic­

ture further ,  depending on the size of the obj ects in the zoomed 

area .  

Full  Size 

FullSize allows you to return a zoomed picture to  i ts  full size in 

the graphics area .  

To return a picture to the full s ize of the graphics area :  select  

Fui iS ize .  The current picture zooms out to  i ts  original s ize .  

Magnify 

M agnify allows you to magnify a portion of the current picture to  

the  size of the  graphics area.  You  can view fine detai l  and  draw 

with much greater precision on a zoomed picture .  

To zoom a picture :  

1 .  S elect  Magnify. A box appears on the screen.  

2.  Use the arrow keys to make the box smaller  or larger,  

and press  < Return > . (The smaller the box, the greater 

the magnification will  be . )  

3 .  Use the arrow keys to move the box to  a location that  

contains the portion of the picture you want  to  magnify, 

and press < Return > . 
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NOTE: You cannot modify a zoomed obj ect that extends beyond 

the graphics area. Select FuliSlze before modifying the obj ect . 

Pan 

Pan allows you to  magnify a different portion of a zoomed pic­

ture .  Pan is not selectable unless the current picture has been 

zoomed with the Magnify command. 

To pan a zoomed picture :  

1 .  S elect Pan.  A box appears on the screen .  

2.  Use the arrow keys to move the box so that it  moves off 

the screen to contain a new portion of the picture ,  and � 
press < Return > . The new portion of the picture is  

magnified .  

Quit 

Sekect Quit  to  leave the Zoom menu and return to  the Draw 

menu.  

ADD CHART 

AddChart allows you to  add a copy of the current chart to  the 

Draw graphics area,  in order to  enhance it with addit ional  text 

and graphics . There must be a current chart in the Chart � 
graphics area for AddChart to be selectable .  
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S elect AddChart to choose from these items : 

• ADD Add the current chart to  the Draw 

graphics area 

• REPLACE Replace an obj ect in the Draw graphics 

area with the current chart 

• QUIT Return to  the Draw menu 

D 

� Sales 
Cereals 

Figure 3·11 Placing two charts on a page 
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For example,  you might perform the following steps to place two 

charts on one page, as shown in Figure 3 - 1 1 :  

Create a vertical b a r  chart .  (Chart/Data) 

Add the chart to  the Draw graphics area.  

(Draw/ Add Chart/ Add) 

Scale the chart smaller .  (Modify/Scale) 

Move the chart to  a corner of the graphics area. (Modify/Move) 

D raw a box in the opposite corner of the graphics area .  

(Create/B ox) 

Create a pie chart from one of your data sets .  

( Chart/ChartType/Pie)  

Replace the box you drew with the pie chart .  

(Draw/ Add Chart/Replace) 

Draw a frame around the pie chart and add text to  explain char t s .  

(Create/Box, Create/Text) . 
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Add 

Add allows you to add a copy of the current chart to the Draw 

graphics area .  If there is a picture in the Draw graphics area ,  the 

chart is added to  i t .  

To add a char t :  

1 .  Select AddChart .  

NOTE: A chart you add to the Draw graphics area appears as a 

symbol .  To modify the chart ' s  graphic elements ,  you must first  

undo the symbol .  To undo the symbol :  select  

Draw/Modlfy/Group/UndoSymbol .  

Replace 

R eplace allows you replace an obj ect in the Draw graphics area 

with the current  char t .  For example,  you can arrange multiple 

charts on a page, then replace them with different  char t s .  A chart 

approximates  the size and shape of the obj ect i t  replaces .  

To  replace an obj ect with the current chart : 

1 .  Select Replace .  

2 .  Se lect the outer edge of the obj ect you want to  replace . 

3 .  Select one of the fo llowing :  
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- ReplaceObject 

Replace the obj ect with the 

current chart 

- SelectNewObject 

Select a different obj ect to  

replace 

NOTE: A chart you add to the graphics area appears as a sym­

bol .  To modify the chart ' s  graphic elements ,  you must first  undo 

the symbol  by selecting UndoSymbol.  

Quit 

Select Quit to  leave the AddChart menu and return to  the Draw � 
menu. 

QUIT 

Select Quit to  leave the Draw menu and return to  the SCO Image­

B uilder main menu. 
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Charting Commands 

Chart 

Chart allows you to create line, bar, area,  pie,  scatter ,  or  mixed 

charts from your data .  Charts are drawn in the Chart  graphics 

area, a blank area on the screen. 

You may enter your data directly or import it from an SCO 

Professional worksheet .  Your data is automatically drawn as a 

vertical bar chart ,  but you can easily create several types of charts 

from the same data .  Once you have created a chart ,  you can add 

� it t o  the Draw graphics area for further enhancement . 

A chart may contain the following graphic elements ,  some of 

which are illustrated by Figure 3-12 : 

B ackground color 

X axis and Y axis 

Axi s labels 

Titles 

Legend 

Pie slice labels 

A grid 

Chart functions are performed on the curren t  chart, which ap-

� pears  when Chart is selected.  The current chart may be an empty 

graphics area, a newly-created chart ,  or a chart you re tr ieve with 

the Chart  File command, Get .  
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y Axis 
Labels 

L... 

Chart Tille 
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rma B  

40 

L� 
Figure 3-12 The components of a chart 

Select Chart to  choose from these menu items:  

• DATA Enter and edit data for a chart 

• CHAR TTYPE Choose a chart type 

• OPTIONS Set  chart options 

• LAYOUT Add ti t les and determine graphic layout 

• ERASE Erase the current chart 

• TRANSFER Transfer a chart between SCO 

ImageBuilder and other programs 

• PRINT Preview or print the current chart 

• FILE Get, add, save, or delete charts  

• QUIT Return to the main ImageB uilder menu 
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DATA 

Data allows you to enter data into the Data d isplay. To create a 

chart, you must first enter values and labels into the Data display. 

Whether you obtain your data from a spreadsheet, a report, or 

compile it from several sources, the Data d isplay allows you to 

organize and label  it  for charting. For example,  you might per­

form the following tasks to enter data for a chart, as i l lustrated 

by Figure 3 - 1 3 :  

Enter X-axis labels for quarterly data. (Data/DataEntry) 

Enter legend labels for two products. (Data/DataEntry) 

Enter values for quart erly sales. (Data/DataEntry) 

Chart/Data Vers ion 1 . B 
DataEntry Ca lendar EraseData Qu it 

Figure 3-13 Values and labels in the Data display 
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SCO ImageBuilder automatically plots your data as a vertical bar � 
char t .  You can see your data plotted in a variety of chart types 

by selecting ChartType .  You can bring SCO Professional spread-

sheet data or SCO FoxBASE data into the Data display by select-

ing Transfer/Paste .  

S elect Data to  choose from these items : 

• DATAENTRY Enter data values 

• CALENDAR Automatically add monthly labels 

• ERASED AT A Clear the Data display 

• QUIT Return to the Chart  menu 

DataEntry 

D ataEntry allows you to  enter your chart data .  You add, change, 

or  delete values and labels in specific areas of the D ata  display. 

• You entervalues in vertical columns in the on­

bracketed locations of the Data display. A data 
set i s  a column of values .  Values must be between 

-9,999,999 .99 and 9,999,999 .99.  You can have up 

to  50 values in a data set .  A chart can have up to 

five data sets .  

• You enter X axis labels (of up to 10 characters) in  

the brackets at  the left s ide of the display. (These 

labels are also pie slice labels . )  
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,....-.... • You enter data set names (of up to  10 characters)  

/ ...... 

in the brackets at the top of each column of 

values .  Data set  names appear in a char t ' s  legend 

To enter or replace a value or label :  

1.  S elect DataEntry. Use the arrow keys and < Home > , 

< End > , < PGUP > ,  or < PGDN > t o  move the cursor 

t o  a value or label location.  

2 .  Type a value or label ,  and press < Return > . 

(To insert a value or label in a data se t :  press  < F3 > ,  

type in the new entry, and press < Return > . To delete 

an entry: press < F4 > .) 

3 . Press  < ESC > twice to see a chart drawn from your 

data .  

Calendar 

Calendar allows you to  automatically add monthly labels in the 

left column of the D ata display. 

To add monthly labels :  

1 .  S elect Calendar.  

2 .  Press < ESC > to  see your chart drawn with monthly 

labels . 
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EraseData 

EraseData allows you to erase all values and labels from the Data  

display. Once  you  select EraseData, you have a chance to  cancel 

your request to  erase the contents of the Data display. If the cur­

rent chart is unsaved, you may want to  save it before you erase i t  

permanently. Once you select Erase,  you have two choices :  

• CANCEL Return to the Data menu without 

erasing the Data display 

• CLEARDAT A Completely clear the Data 

display of both values and labels 

To erase the D ata display: 

1. S elect Erase.  

2 .  Select Cancel to  return to the Data menu without eras­

ing,  or  ClearData to erase the chart  data.  

NOTE: EraseData does not erase the current char t ' s  type or op­

tions . To change chart type for the next chart :  select ChartType .  

To change chart options :  se lect  Options . 

CHARTIYPE 

ChartType a l lows you to create several di fferent  chart  types from 

your data .  The chart  type you choose depends on the kind of data 

3-66 



Command Reference • Charting 

� you have and the message you want to  convey. You might choose 

to  create more than one chart  type from your data for  an in-depth 

look at the numbers .  Decide what  you want to  show,  and then let  

SCO ImageBuilder expertly draw one or more chart types  from 

the data you enter .  

For t ips on creating good graphic chart images, see  the section 

"Building a Better Data  Chart"  in Part One:  In troduction, Presen­

tation Graph ics. 

S elect ChartType to choose from these i tems:  

• VERTICALBAR 

• LINE 

• S CATTERPLOT 

• AREA 

• MIXED 

Create a vertical bar chart 

Create a line chart 

Create a scatter chart 

Create an area chart 

Create a mixed chart by combining 

vertical bar,  l ine, area,  or  scatterplot  

• HORIZONT ALBAR 

Create a horizontal bar chart 

• PIE Create a pie chart from a single data set 

• Q UIT Return to the Chart menu 
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Vertical Bar 

VerticalB ar allows you to create a vertical bar chart from your 

data. Vertical bar charts are useful for comparing quantities or 

for showing values at corresponding intervals. Considered the 

business standard, b ar charts are easiest to  read.  Data you enter 

into the Data display is automatically turned into a vertical bar 

chart ,  unless  you have selected another chart type before enter­

ing your data .  

Figure 3-14  compares 1st  quarter monthly sales  by city. Each 

group of b ars shows a quantitative difference, while a trend over 

time is also evident. 
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Figure 3-14 A vertical bar chart 
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To create a vertical bar char t :  select Vertical  Bar .  

The current char t  is redrawn as a vertical bar char t .  

Options you  can  change for vertical bar  charts include color ,  pat­

tern,  and visibility. To change options : select Chart/Option s .  

Line 

Line allows you to  create  a l ine chart from your data .  Line charts 

are useful for tracking trends over time, or for showing larger 

amounts of  data.  You can use them to chart the differences be­

tween variables,  showing frequency or distribution .  Keep the 

number of  l ines per chart  small  for clarity. I f  you have only one 

line in a chart ,  plot it  as an area chart  for  more graphic impact . 

1 00 

80 

Sales H istory NW 
sw 

60 -----------------------

40 -----...... ... ... -
20 

_ ... -... --

0 �--------.----------r--------� 
84 85 86 

Figure 3-15 A line chart 
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Figure 3-15  traces sales trends for two regions over a four year 
l period.  

To create a l ine chart :  select  Line .  The current chart  is  redrawn 

as a line chart .  

Opt ions  you can change for l ine charts include color ,  p attern,  and 

visibility. To change options:  select Chart/Options .  

Scatter Plot 

ScatterPlot allows you to  create a scatter chart from your data .  

S catter charts  plot each value as a marker symbol .  They are use­

ful  for showing data as distinct points  in t ime,  or  for plotting 
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Figure 3-16 A scatterplot chart 
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coordinates of  two sets of data not directly related to time, such 

as advertis ing costs and sales.  

Figure 3 -16  shows the rise in temperature of a test  substance in 

relation to increasing units of gas .  

To create a scatter chart :  select ScatterPlot. The current chart 

is redrawn as  a scatter chart .  

Opt ions  you can change for scatter charts include color ,  marker 

style ,  and visibility. To change options:  select Chart/Options .  

Area 

Area al lows you to create an area chart from your data .  Area 

charts are line charts with the area below the line fil led in .  They 

Product Performance 
125�----------------------� 

• AX200 
100 Cill Beta T AC 

75 

Figure 3-17 An area chart 
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are useful for comparing volume trends over t ime.  Plot  the data 

for the product with the highest values first ,  because the second 

area is  drawn over the firs t .  

Figure 3 -17  compares  quarterly sales  of two products .  

To create an area chart :  select Area . The current chart is  

redrawn as an area chart .  

Options you can change for  area  charts include color ,  pattern,  

and visibility. To change options:  select Chart/Options . 

Mixed 

Mixed allows you to create a chart that combines vertical bar,  � 
l ine, area,  or scatter chart types .  Mixing chart types lets you tell  

a more complex story about your data.  

Figure 3-18 shows projected sales as an area chart and actual 

sales as a bar char t .  

To create a mixed char t :  

3-72 

1 .  Se lect Mixed. 

2 .  S elect a chart type for the first  data set  in your chart .  

Continue to  select a chart type for each data set  in the 

char t .  

3 .  S elec t  Done to see  your  char t  drawn on  the . screen .  
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Figure 3-18 A mixed chart 

Options you can change for mixed charts include color ,  data set  

type,  pattern,  marker style, and visibility, depending on the chart  

types you have combined.  To change options :  select  Chart/Op· 

t lon s .  

NOTE: Horizontal bar and pie charts cannot be mixed with other 

chart types .  

HorizontaiBar 

/� HorizontaiBar allows you to create a horizontal bar chart from 

your data .  In  this chart,  the X and Y axes are reversed ,  so  that 

the bars  grow from the left s ide of the chart to the right .  H orizon-
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ta l  bar charts are useful for comparing values,  such as lengths of  

t ime or amounts of money, against a time line . 

Figure 3 -19  shows the number of new accounts at two banks over 

a five-year period.  

To create a horizontal bar chart :  select  HorizontalBar .  The cur­

rent chart  is redrawn as a horizontal bar char t .  

Options you can change for horizontal bar  charts include color ,  

pattern,  and visibility. To change options:  select Chart/Op·  

tlons . )  

New Accounts 
1st Year 

2nd Year 

3rd Year 

4th Year 

5th Year 

0 . 100 200 300 400 500 

Figure 3-19 A horizontal bar chart 

NOTE: Since the X and Y axes are reversed in this chart ,  func­

t ions you perform on the X axis (such as scaling or  entering an 

axis title) apply to the vertical axis .  Funct ions you perform on the 
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Y axis apply to the horizon tal axis .  Because of the reversed axes ,  

a horizontal  bar cannot be included in a mixed char t .  

Pie 

Pie allows you to create a pie chart from one of the data se ts  in 

the Data display. Each value is represented as a pie slice show­

ing the percentage of the value in relation to  the whole ( 100% ) . 

You can have up to  16 slices, but a pie composed of six or  less  

s l ices  is  easiest  to read.  The largest s l ice often  looks best  dis ­

played in the lightest  tone . 

Figure 3 -20 shows the proport ional contribution of  three 

salespeople to a company' s annual sales .  

Sales Performance 

J. Smith 21% 

E. Jones 42% 

Figure 3-20 A pie chart 

3-75 



SCO ImageBuilder User's Guide 

To create a pie chart :  

1 .  Select Pie.  Data set names appear on the menu l ine.  

2.  S elect the name of a data set .  The chart  is redrawn as a 

pie chart using the data from the data set you selected.  

(To see data set  values:  select Chart/Data. To change pie chart 

drawing characteristics: select Chart/Options . )  

Quit 

Quit  allows you to exit the ChartType menu and return to the 

Chart menu.  

OPTIONS 

S elect Options to set  chart options. Options determine the draw­

ing characteristics of the current chart. Each chart type has a 

unique set  of options.  

You change most options by data set. (A data set  i s  a vertical 

column of values in the Data display . )  For example, in a b ar 

chart,  al l  b ars for a s ingle data set are the same color and pat­

t ern.  Options for pie charts  are set by the pie slice . 

Depending on the current chart's type,  you can set  the following 

options:  

• COLOR Select chart colors [al l  chart types] 
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Separate a pie slice from the whole pie 

chart [Pie only] 

Change the pattern of a l ine,  bar ,  area,  

or pie s l ice [all  chart  types  except 

Scatter Plot] 

Make a data set  visible or invisible 

on a chart [all  chart types  except Pie] 

• MARKERSTYLE 

Change the style of a marker [ScatterPlot 

and Mixed only] 

• DATASETTYPE 

Change chart type for individual data sets  

[Mixed only] 

• QUIT Return to the Chart menu [ al l  chart types]  

Color 

Color allows you to  change the color of a data se t  or  pie sl ice . 

To change data set  or pie slice color :  

1 .  S elect Color.  

2 .  Select  a data set  or pie sl ice name. 

� 3 .  Select  the color you want .  (Move the cursor over the ar-

rows at either end of the l ine to  view al l  the color 

choices . )  
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4. Press < ESC > to see your chart redrawn. 

(To change the palette :  select Palette from the main menu.)  

Explode 

Explode al lows you to emphasize a pie sl ice by separating i t  from 

the whole pie, as shown in Figure 3-21 ,  or to reunite an exploded 

slice with the whole pie.  For each s l ice you have two choices:  

• EXPLODEON S eparate a slice from the 

whole pie 

• EXPLODEOFF Recombine an exploded slice 

with the whole pie 
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� To explode a pie sl ice :  

1 .  S elect  Explode.  Pie sl ice names appear on  the  menu 

line . 

2 .  S elect  the name of a pie sl ice .  (To see pie  sl ice data 

values :  select Chart/Data . )  

3 .  S elect ExplodeOn to separate the slice from t h e  pie ,  o r  

select  ExplodeOff t o  j oin the slice with t h e  pie .  

4.  Press  < ES C > to see the pie chart  redrawn with the ex­

ploded slice . 

Visibil ity 

Visibility allows you to make a data set  visible or invisible (not  

used) in the current  chart .  

Visibility controls  whether or not a data set  in the Data  display 

actually appears in the current char t .  For each data se t ,  you have 

two choices :  

• VISIBILITYON 

Ensure that the data set  i s  plot ted 

and visible on the chart 

• VISIBILITYOFF 

Make the data set  invisible by not  using 

it in the chart 
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To se t  visibility: 

1. Select Visibi l ity. 

2. S elect a data set name . (To see data set values :  select  

Chart/Data . )  

3 .  Se lec t  Visibi l ityOn to make the  da ta  set  visible .  S elect  

Visibi l i tyOff t o  make the data set  invis ible .  

4 .  Press  < ES C > to see your chart redrawn. 

(Changing visibility may affect the chart axis limi ts .  To set  your 

own axis l imits ,  select XAxis/Scale or YAxis/Scale . )  

Pattern 

Pattern allows you to  change the pattern of lines on a line or 

mixed chart ,  or  the interior areas of bar, area, mixed, and pie 

char t s .  

Patterns other than  hollow and solid do no t  appear on 35mm 

slides or  t ransparencies .  In addition, some displays and output 

devices may not have the capability to  display all the pattern 

choices .  

NOTE: Patterned objects  (except solid) are " t ransparent"  in the 

sense that you can see through them to any obj ects that may be  in  

back of them.  
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1....._ Line Patterns 

Line patterns include : solid, long dash, medium dash,  short  dash,  

dotted,  dash-dot ,  dash- double-dot ,  and double -dot .  

To change l ine  pattern :  

1 .  S elect Pattern. 

2.  S elect the name of a data se t .  

3 .  Select  a l ine  pattern.  

4 . Press < ES C > to see  your chart drawn with a new line 

pattern, or select Pattern again to  change the pattern of 

another l ine .  

Interior Patterns 

Interior area patterns include : hollow, solid,  wide slant ,  medium 

slant, narrow slant, wide hatch, medium hatch, narrow hatch, ver­

tical l ine and horizontal line . 

Finer patterns ( such as narrow hatch ) add texture to  a color ,  

toning i t  down to resemble a gray scale .  Some displays and out­

put devices may not have the capability to  display all the pattern 

choices .  

To change interior pattern :  

1 .  S elect Pattern . 

2 .  S elect the name of a data se t .  
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3 .  S elect an interior pattern.  (Scroll the patterns that ap­

pear on the menu line by moving the cursor over the ar­

rows at either end of the line . )  

4 .  Press  < ES C > to  see your chart drawn with a new pat ­

tern ,  or  select Pattern again to change the pat tern  of  

another bar ,  area,  or p ie  slice . 

MarkerStyle 

M arkerS tyle allows you to  choose a marker style for scatter  

chart s .  Marker s tyles  include :  sol id box, hollow box,  diamond, 

tr iangle ,  plus,  and X. 

1 .  Select MarkerStyle.  

2.  Select the name of a data set .  

3 .  S elect a marker style .  

4 .  Press  < ESC > to  see your chart drawn with a new 

marker s tyle ,  or  select  MarkerStyle again to  change the 

s tyle of another data set .  

DataSetType 

D ataSetType allows you to  change the chart type for a data set in 

a mixed char t .  

To change data set  type :  

1 .  Select DataSetType. 
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2 .  S elect the name of a data set  t o  change . (To see  data 

se t  values :  select  Chart/Data . )  

3 .  Select a chart  type for  the data se t .  

4 .  Press  < ES C > to  see your chart drawn wi th  a new chart 

type .  

Quit 

Se lec t  Quit  to  exit the  Options menu and return to  the Chart  

menu.  

LAYOUT 

Layout allows you to lay out the look of a char t .  You can add t i t ­

les ,  place a legend,  add a grid,  reformat the axes , or  create s tack­

ed  bar and area chart s .  

Select  Layout to  choose from these i tems:  

• TITLES Add or edit chart titles 

• XAXIS Set  X axis attributes 

• YAXIS Set  Y axis attributes 

• LEGEND Place or remove a chart legend 

• STACK Arrange bars or areas one above the other 

• QUIT Return to the Chart menu 
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For example, you might perform the following tasks t o  improve 

the graphic layout of a line chart, as shown in Figure 3 -22 :  

Rescale the  Y axis to  smooth ou t  up- and-down sales figures .  

(Layout/Y Axis/Scale) 

Change Yaxis labels to  whole numbers to  simplify chart .  

(Y Axis/Precision/NoDecimals) 

Remove the legend, because the chart plots only one data 

se t .  (Legend/LegendOff) 

Change the chart ' s  type to an area chart .  (ChartType/Area) 

Add a grid.  (Y Axis/Grid) 

Add a main t i t le .  (Titles/Main) 
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Titles 

Titles allows you to add four types of t i t les to a chart ,  as  i l ­

lustrated by Figure 3 ·23 . Titles are drawn on the screen in a draft 

mode (outline only) to  speed drawing t ime.  Titles appear in final 

mode (filled-in) when you select Print t o  preview a chart or  print 

it to  an output device . 

Main Title 
Subtitle 

100 y Tille 

.� 80 
60 
40 
20 

0 
X Axle 11tle 

Figure 3-23 Chart titles 

S elect Titles to choose from these items : 

• MAIN Add or edit a main t i t le 

• SUBTITLE Add or edit a subtitle 
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• XAXIS Add or edit an X- axis title 

• YAXIS Add or edit a Y - axis t i t le 

• QUIT Return to  the Layout menu 

NOTE: To move or  change the size of chart t i t les ,  add the chart 

t o  the Draw graphics area by selecting Draw/AddChart.  

Main 

The main t i t le appears at the top left of the chart . Select  Main 

to  choose from these i tems:  

• ENTER Enter text for the main title 

• COLOR Select color for the  main tit le 

• FONT Select font s tyle for the main tit le 

• DELETE Erase the main tit le 

• QUIT Return to the Tit les menu 

Subtitle 

The subtitle appears at the top left of the chart,  beneath the main 

t i t le (if one exis ts ) . Select Subtitle to choose from these i tems :  

• ENTER Enter text for the subtitle 

• FONT Select font style for the subtitle 
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• COLOR Select color for the subtit le 

• DELETE Erase the subtitle 

• QUIT Return to  the Tit les  menu 

XAxis 

The X- axis t i t le  appears  at the bottom center of the chart ,  

beneath the X axis .  Select XAxis to  choose from these i tems :  

• ENTER Enter text for the X- axis t i t le 

• FONT Select font style for the X-axis t i t le 

• COLOR Select color for the X-axis t i t le 

• DELETE Erase the X-axis t i t le 

• QUIT Return to  the Titles menu 

NOTE: O n  a horizontal bar chart, the X and Y axes are reversed .  

Therefore ,  the X-axis title appears at the top left of  th i s  char t .  

YAxis 

The Y - axis t i t le appears at the top left of the chart ,  close t o  the 

Y axi s .  S elect YAxis to  choose from these menu i tems:  
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• ENTER Enter text for the Y - axis t i t le 

• FONT Select font style for the Y - axis t i t le 

• COLOR Select color for the  Y - axis t i t le 

• DELETE Erase the Y -axis title 

• QUIT Return to  the Tit les  menu 

NOTE: On a horizontal bar chart, the X and Y axes are reversed .  

Therefore ,  the Y - axis t i t le  appears at the bottom center  of th is  

char t .  

Enter 

Enter allows you to  type in the text of a t i t le .  

To create a t i t le :  

1 .  S elect Enter. Type a title (of up to  31 characters) , and 

press < Return > . 

2 .  Press  < F9 > to  see your chart redrawn with the t i t le . 

3 .  Press  < ES C > to  return to the Titles menu. 

Color 

Color allows you to  change the color of a chart t i t le . 
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� To change ti t le color :  

1 .  S elect Color. 

2 .  M ove the cursor to  the color you want, and press 

< Return > . (Move the cursor over the arrows at ei ther 

end of the l ine to  view al l  the color choices . )  

3 .  Press  < F9 > to see  your chart title redrawn in a new 

color . 

4 .  Press  < ES C > to  return to  the Titles menu.  

(To change color palet tes :  select  Palette from the main menu.)  

Font 

Font allows you to  change the font for a chart t i t le .  Fonts  include 

l ight ,  bold,  classic,  italic light, italic bold,  and s crip t .  

Font s  are drawn on the  screen in  a draft mode  ( outline only) to  

speed drawing t ime .  Fonts appear in  final mode  ( fi l led-in) when 

you select Print to  preview a chart or print it on an output device .  

To  change a t i t le font :  

1 .  S elect  Font .  

2.  S elect a font .  

3 .  Press  < F9 > t o  see  your char t  t i t le  r ed rawn in  a new 

font .  
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4. Press  < ES C > to return to the Titles menu.  

Delete 

Delete  allows you to delete a tit le .  

To delete a tit le : 

1 .  Select Delete.  

2 .  Press < F9 > to  see the chart redrawn without the t i t le .  

3 .  Press  < ES C > to  return to the Tit les  menu.  

Quit 

S elect Quit to  exit a specific t i t le  menu and return to  the Tit les  

menu.  

XAxis 

Select XAxis to  choose from these items:  

• AUTOSCALE Let SCO lmageBuilder automati­

cally set  the range of the X axis 

• S CALE Set your own range for the X axis 

• GRID Add or remove a vertical grid 

• QUIT Return to the Layout menu 
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YAxis 

S elect YAxis t o  choose from these menu items : 

• AUTOS CALE Let SCO ImageBuilder automati­

cally set the range of the Y axis 

• S CALE Set  your own range for the Y axis 

• PRECISION Select the format of Y - axis labels 

• GRID Add or remove a horizontal gr id 

• QUIT Return to the Layout menu 

AutoScale 

AutoScale allows you to  have the program automatically se t  the 

range for the X or Y axis .  

AutoS cale for  the X axis plots  a l l  the values in the Data  display.  

AutoScale for the Y axis calculates the lowest and highest values 

of the Y axis and determines the spacing of Y axis labels .  

To let  the program automatically scale  an axi s :  

se lec t  Autoscale .  

(To set  your own l im i t s  for t he  X and  Y axe s :  se lect  XAxis/Scale 

or  YAxis/Scale . )  
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Scale 

S cale allows you to  set  your own limit s  for the X or  Y axis ,  as  

shown in Figure 3-24 .  You can change the way your chart looks 

when it  i s  plotted,  or choose to show only a portion of your data 

by rescaling an axi s .  

To sca le  the X Axis :  

1 .  Select Scale .  

2 .  Type the number of the horizontal row of values in the 

Data display with which you want to start  the X axi s .  

3 .  Type the  number of the  horizontal row of values in the  

Data  display with which you  want to  end  the  X axis .  

4 .  Type an X-axis step size ( incremental spacing of X-axis 

labels) , and press < Return > .  

5 .  Press  < ES C > to  see a portion of your data plot ted 

along the rescaled X axis .  

To scale  the Y Axis :  

1 .  S elect  Scale . 

2 .  Type a value to  start the Y axis ,  and press < Return > . 

3 .  Type a value to e n d  the  Y axi s ,  and  press  < Retu rn > .  
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4. Type a Y - axis step size (incremental spacing of Y - axis 

labels) , and press < Return > .  

5 .  Press  < ES C > to see your chart drawn with a rescaled 

Y axis .  

7 7  78 79 80 81 82 83 84 85 86 87 86 

Chart with 
automatically-scaled 

axes 

Chart with user-scaled axes 
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0 
-200 77 79 81 83 85 87 

Figure 3-24 Axis scaling 

3-93 



SCO ImageBullder User's Guide 

Precision 

Precision al lows you to  change the appearance of Y - axis labels . 

S elect ·Precis ion to  choose from these i tems:  

• NODECIMALS 

Show Y - axis labels as whole numbers  

• ONEDECIMAL 

Give Y -axis labels one decimal place 

• TWODECIMALS 

Give Y -axis labels two decimal places 

• DOLLARS Show Y - axis labels as dollars 

To set  Y - axis label  precision:  

1 .  Select  Precis ion .  

2.  S elect a precision choice . Press < ESC > t o  see  your 

chart with new label precision . 

Grid 

Grid allows you to  create or remove a background grid for a 

char t .  A grid provides visual reference points for plot ted data .  

An X- axis gr id creates  vertical gr id l ines ,  while a Y - axis gr id 

creates horizontal gr id l ines .  Us ing both an X- and a Y -axis gr id 

creates a gr id of intersecting lines .  
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For each axis ,  you have two choices :  

• OFF Show no grid lines 

• ON Show grid lines 

NOTE: On horizontal bar char ts ,  the X and Y axes are reversed,  

so  that an X- axis gr id creates  horizontal l ines  and a Y - axis grid 

creates vertical lines .  

To s e t  a grid :  

1 .  S elect Grid.  

2 .  S elect  On.  (An X- axis grid shows vertical l ines ,  while a 

Y - axis grid shows horizontal lines . ) 

3 .  Press  < ESC > to  see your chart drawn with a grid .  

(To remove a grid:  select Off. ) 

Quit 

S elect  Quit  to  exit the XAxis or Y Axis menu and return to  the 

Layout  menu.  

Legend 

.� Legend allows you to  place a legend in or remove it from the cur­

rent char t .  A legend identifies the data se ts  represented in the 
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chart .  (Pie charts do not have legends . )  You have three choices : 

• LEGEND OFF Show no legend on the chart 

• LEGENDINSIDE 

Place a legend inside the perimeter 

of a chart 

• LEGENDOUTSIDE 

Place a legend outs ide the perimeter 

of a chart 

To place a legend:  

1 .  S elect  Legend .  

2.  S elect  Legendlnslde ( to  place the legend ins ide the 

chart frame ) ,  or  LegendOutslde ( to  place the legend 

outside the chart frame) . 

To remove a legend:  

1 .  Select Legend.  

2 .  S elect LegendOff. 

Stack 

S tack allows you to arrange bars or areas one above the other to  

show a to tal ,  cumulative amount, as shown in  Figure 3 ·25 .  Each '\. 
bar or  area uses  the top of the previous bar or area as i ts  base .  

S tacking shows the contribution of each par t  to  the whole, but un-
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Figure 3-25 A stacked bar chart 

l ike pie chart s ,  stacked charts reflect actual values ,  not  percent­

ages .  

Y o u  have two choices :  

• ST ACKINGON Turn on stacking of bars  or  areas  

• ST ACKINGOFF Turn off s tacking of bars or  areas 

To  set  s tacking: 

1.  Select S tack. 

� 2 .  Select  StacklngOn to  show bars and areas one above the 

other ,  or  StackingOff to show bars and areas without 
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s tacking . 

NOTE: H orizontal bar char ts  stack bars one after  the other .  

ERASE 

Erase allows you to  erase the current chart .  Once you select 

Erase ,  you have a chance to  cancel your request  to  erase the 

graphics area .  If  the current chart is unsaved, you may want to 

save i t  before you erase it  permanently. There are two choices :  

• CANCEL 

• CLEARCHART 

Cancel the request to erase the 

current chart and data,  in order 

to  resume work in the Chart menu, or  

save your chart  with the File command 

Completely erase the current chart and data 

To erase the current char t :  
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1. S elect Erase .  

2 .  S elect Cancel  to  return to the Chart menu without  eras­

ing ,  or C learChart to erase the current chart .  
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TRANSFER 

Transfer allows you to  import or export the current chart between 

SCO ImageB uilder and other programs,  via the Clipboard .  

Select  Transfer to  choose  from these  i tems :  

• COPY 

• PASTE 

• REMOVE 

• QUIT 

Copy 

Copy the current chart t o  the Clipboard 

Transfer a chart from the Clipboard to  the 

Chart  graphics area 

Remove a chart from the Clipboard 

Return to the Chart  menu 

Copy allows you to  copy the current chart  to  the Clipboard .  

To copy a chart  to the Clipboard:  

1 .  S elect C opy. 

2 .  Type in a description of the chart (of up to 14 charac­

ters) , and press < Return > .  A copy of  the chart is  

transferred to the Clipboard.  From there ,  you can 

transfer the chart to other programs.  
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Paste 

Paste allows you to bring a chart from the Clipboard to paste into 

the Chart graphics area .  The chart  you paste replaces the cur­

rent chart .  

To paste  a chart into the Chart graphics area:  

1 .  Select Paste.  If  the current chart is unsaved, select one 

of the following: 

- Stop Return to the Transfer menu 

- Continue Replace the current chart 

2 .  S elect an item from the Clipboard to  paste.  The chart 

you select becomes the current chart .  

Remove 

Remove allows you to  erase a chart from the Clipboard.  

To remove a char t :  

1 .  Select Remove. 

2. S elect the name of a chart to remove . 
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Quit 

Quit allows you to  exit the Transfer menu and return t o  the Chart  

menu.  

PRINT 

S elect Print to  preview the current chart on a full screen or 

produce finished output.  

• PREVIEW 

• OUTPUT 

Preview 

Preview the current chart,  enlarged 

to  the size of the screen 

Produce final output 

Preview allows you to see the current chart  on a full screen,  so  

that you can get  a bet ter  idea  of how the  finished char t  will look .  

To preview the current chart :  

1 .  S elect Preview. 

2. Press  < Space Bar > to stop the preview. 

NOTE: If  you have a color monitor that displays at  least 32 

colors ,  Preview allows you to  view a gradat e d  background .  
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Output 

Output allows you to  produce output on a printer, plotter ,  or 

camera device . (For instructions on sett ing up SCO Image­

Builder with your output device, refer to the Release and Instal­

lation Notes that came with the manual, or contact your system 

administrator . )  

To produce output : 

1 .  Se lect Output .  

2.  S elect the name of an output device.  

NOTE: You may continue working with SCO ImageBuilder while 

your output is being produced. 

FILE 

Select File to  choose from these menu items: 

• GET Get  a chart 

• SAVE Save the current chart 

• DELETE Remove a chart file 

• CHANGEDIR Change the current directory 

• IMPORT Import  data from an SCO P·rofessional 

worksheet 
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• QUIT Return to  the Chart  menu 

Get 

Get allows you to  retr ieve a chart file .  The chart you get replaces 

the current  chart in the graphics area .  The name of  the chart ap­

pears on the screen sidebar.  

S ince you are actually getting a copy of the chart file ,  you can 

make changes to it and even erase it  from the graphics area 

without affecting the original chart .  The original version remains 

unaffected,  unless you delete it from the file or replace it  when 

you save the revised version.  

To get  a char t :  

1 .  S elect Get .  If the  current chart is unsaved, se lec t  one of  

the following : 

- Stop Return to  the File menu 

- Continue Replace the current  chart 

2 .  S elect the name of a file to get .  (Press < PGDN > to 

scroll  the File display if the file does not  appear on the 

screen.)  

3 .  Press  < ES C > to see the chart  drawn on the screen .  
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Save 

Save allows you to save the current chart to produce as output or  

revise la ter  on .  

To save the current .chart :  

1 .  Select Save.  

2 .  D o  one of the following: 

- To save the chart under a new name 

Select NewFile , type a name,  and press  

< Return > .  

- To save the chart by replacing a file 

Select the name of a file you want to replace.  

Then, select Replace to replace the file ,  or  

Quit to return to the File menu. 

Delete 

Delete allows you to remove a chart file .  

To delete  a chart  file :  

1 .  Select Delete .  
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2. S elect the name of the fi le to dele te .  (Press  < PGDN > 

t o  scroll the File display if the file does not  appear on 

the screen . )  

ChangeDir 

ChangeDir allows you to change the current directory, in order 

to  get files  from or save images into other directorie s .  

To change the  current directory: 

1. S elect ChangeDir.  

2.  Do one of the following : 

- If you see the n ame of the directory you wan t 

Select the name. (The single dot  ( . )  in the list 

of directory names is  the current directory.  

The double dot ( . . ) is the parent directory.)  

- If you do not see the name of the directory 

lmportWKS 

Select NewDirectory, then type the directory 

name, and press < Return > . 

ImportWKS allows you to import data from an SCO Professional 

worksheet  into the SCO ImageBuilder Data display.  You can im-
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port  up to five data sets  of 50 values each. Worksheet data 

replaces any data you may have in the Data display, but  does  not  

al ter the current  chart  type or chart options . 

To import data from SCO Professional:  

1. S elect  ImportWKS . The names of WKS files appear on 

the screen.  

2 .  Select  the name of the WKS file you want to  import .  

QUIT 

S elect Quit to  exit the Chart menu and return to  the SCO Image­

Builder main menu. 
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Background & Palette Commands 

BACKGROUND 

B ackground allows you  to change the  color of the background, or  

to  create
. 
a gradated background between two colors .  You can 

change the background color at any t ime.  The background color 

is l isted on the screen sidebar on the right side of the graphics 

area .  

The default background color is black .  A black background on 

the screen appears white on printed output . A gradated  back· 

ground can be produced by printers and cameras capable of dis·  

playing at least  32 colors .  Plotter output does  not  show back­

ground color . 

S elect Background to  choose from these i tems:  

• S O LID Create a sol id background color 

• SHADED Create a gradated background 

Solid 

S olid allows you to  display a background composed of one sol id 

color .  

To create  a solid background: 
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1 .  Select Background.  

2 .  S elect  S ol id .  The 16 colors of the current palette ap­

pear on the menu line . (Move the cursor over the ar­

rows on the menu l ine to  view all  the color choice s .) 

3 .  S elect  a color .  The background color changes .  

Shaded 

Shaded allows you to  create a gradated background. 

To create a gradated background: 

1. Select Background.  

2.  Select Shaded.  The 16 colors of the current palette ap­

pear on the menu line . (Move the cursor over the ar­

rows on the menu l ine to  view all  the color choices . )  

3 .  Select a top background color.  

4 .  S elect  a bottom background color .  

NOTE: O nly the top color of a gradated background appears in 

the graphics area on a color screen. To view a gradated back­

ground on a display with the necessary color capability: select 

Print/Preview, once a current picture or chart exist s .  
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PALETTE 

Palet te  allows you to get ,  change, save, or delete a color palet te .  

A color palette is  se t  of 16 colors .  SCO ImageBuilder comes with 

a collection of eight palet tes .  You can change the colors of  a 

palet te  by "mixing" colors,  just  as an artist  would, t o  create new 

shades .  

Each shade is  a unique mixture of hue  (color  family) , saturation 

( amount of white mixed in) , and intensity (brigh tness) . To create 

a new palet te ,  you can change the colors of a palet te  and save i t  

under  a new name.  

I t ' s  a good idea to  create sample color output ,  so  that  you can see  

what  colors  actually look like on your  output  device .  Although 

SCO lmageBuilder s tores  the colors you set  with the Palette com­

mand, you may not see  their exact shades if your screen or out­

put device displays 64 colors or less .  For example,  SCO Image­

B uilder supports thousands of colors ,  while an EGA shows 64 

colors .  

Se lec t  Palette t o  choose from these  i tems:  

• GET Get  a palette 

• CHANGE Modify the colors of the current palette 

• SAVE Save the current palet te  

• DELETE Delete a saved palet te  
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• QUIT Return to the ImageBuilder m ain menu 

Get 

Get allows you to retr ieve a s aved color palette,  as shown in 

Figure 3 -2 6 .  I f  you have a picture or chart in the graphics area,  

it  changes to reflect the new palette .  Since you are actually get­

ting a copy of the palette file,  you can make changes to it  without 

affecting the original palette. The original version remains unaf­

fected,  unless you delete it  from the file or  replace it when you 

s ave the revised version. 

Figure 3-26 SCO ImageBuilder palettes 

To get a color palette : 

1 .  Select Get. 
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2 .  M ove the cursor to  the name of the palet te  you want,  

and press < Return > . 

I f  you have a color display, the 16 colors of the current palette 

appear across  the bottom of the screen.  If  you have a black-and­

white display, color names are listed at the bot tom of  the screen.  

Change 

Change allows you to modify the colors of the current palett e .  

Once  you  have selected a color to  change, you  create a new color 

to  take i t s  place . 

For example ,  you might perform the following tasks  t o  change a 

color ,  as shown in Figure 3-27 :  

Choose a color from the current palette t o  change . 

(Palet te/Change) 

Change the hue . (DesignAColor) 

Choose a different saturation and intensity .  

( Change/DesignAColor) 

Replace the original color with the new one .  

(Des ignAColor/AddNewColor) 

There are three methods for creating a color : 

• DESIGNACOLOR 

Create a color by mixing i t  in the 

DesignAColor display 
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Figure 3-27 Changing a color in the DesignAColor display 

• R G B  Create a color b y  entering RGB 

(red ,  green and blue) values 

• HSI Create a color by entering HSI  

(hue ,  saturation and intensity) values 
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To change a color : 

1 .  Select  Change. 

The 16 colors of the current palette are listed  in two 

columns on the screen. A cursor box surrounds the 

fir s t  selectable color.  (You cannot change black or 

white ,  which appear in every pale t te . )  

2 .  Move the cursor box with the arrow keys to  the name of 

a color to  change . 

( If  you have a color monitor,  the colors of the current 

palet te  appear across the bottom of the screen.  An 

arrow points to  the color that corresponds to  the color 

name you touch with the cursor . )  

3 .  Press  < Return > .  You are asked to  select  a method to  

create a new color .  

4 .  S elect Des ignAC olor, RGB, or HSI .  

DesignAColor 

To change a color in the DesignAColor display, you select a hue,  

a saturation,  and an intensity to mix a new color . 

1 .  S elect DeslgnAColor .  

Three l ists  appear on the screen:  Hues ,  S aturation,  and In­

tensity .  (You do n o t  have to  press < Return > t o  select 

from the l ists . Simply move the cursor check m ark to 
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the box beside the item.) 

2 .  Select a hue,  saturation, and/or intensity to  create a new 

color .  The name of the new color appears in the lower 

right of the DesignAColor display. If  you have a color 

display, the color block shows the newly mixed color . 

Changing a Color 's Hue 

You se lect a color from the HUES list to  replace a color in the 

current  palet te ,  or  to  use as a base for continued color mixing. 

There are seven color families in the Hues lis t :  Reds ,  Oranges,  

Yellows,  Greens ,  B lues ,  Purples,  and Neutrals . 

The cursor appears as a checkmark, on the name of the color you � 
selected to  change . 

To change hue:  
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1 .  Use the arrow keys to  move the cursor to  a different 

hue.  (To scroll  to different color families :  press 

< PGUP > and < PGDN > . )  The name of the currently 

checked color appears at the lower right of the display.  

(On a color screen, a color block displays each color 

the cursor touches in the HUES lis t . )  

2 .  D o  one of the following: 

- If you want to con tinue  mixing the color 

Press  the < Right > arrow key to  reach the 

SATURATION or INTENSITY l i s t s .  Press  
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< F l  > to select Help for either l ist  and 

receive further instructions on mixing the 

color .  

- If you are satisfied with the color 

Press  < Return > . 

Changing a Color 's Saturation 

S aturation is the amount of white  mixed in with a color .  There 

are four degrees of saturation with white :  Vivid has  no  white ;  

Normal has  a little white ;  Pastel includes lo t s  of  white ;  and Milky 

is mostly white .  

� The cursor appears as a check mark on the saturation of  the 

original  color you selected to change.  

To change saturation:  

1 .  Use the < Up > and < Down > arrow keys· t o  move the 

cursor to  the saturation you want .  The name of the cur·  

rent color changes to include the saturation you 

selected .  (On a color screen, the color block reflects  

e ach saturat ion the cursor touches . )  

2 .  D o  one of the  following : 

If you wata t  to cota tita ue  mixitag the color 

Press a n  a r r ow key to reach the HUES or 

INTENSITY l is t .  Press  < F l  > to  se lect  Help 
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for the list  and receive further instructions on 

mixing the color . 

- If you are satisfied with the color 

Press  < Return > . 

Changing a Color 's Intensity 

Intensity is the amount of light fil tered through a color . There 

are four degrees  of intensity: Bright shows the most  light ;  Nor­

mal shows some light ; Subdued is dimmed with gray;  and D ark 

has most of  the light blocked. 

The cursor appears as a check mark on the intensity of the 

original color you selected to change . 

To change intensity:  
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1 .  Use the < Up >  and < Down > arrow keys to  move the 

cursor to  other intensities ,  until  you find the intensity 

you want .  The name of the current color changes to  in­

clude the intensity you selected.  (On a color screen, 

the color block reflects each intensity the cursor 

touches . )  

2 .  D o  one of the following: 

- If you want to continue mixing the color 

Press  the < Left > arrow key to reach the  

SATURATION or HUE list s .  
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- If you are satisfied with the color 

Press  < Return > . 

Confirming Addition of a Color to the Palette 

Once you have mixed a new color in the D esignAColor display, 

select one of  the following: 

• ADDNEWCOLOR 

Add the new color to  the current palette 

to replace the original color 

• KEEPORIGINALCOLOR 

Return to  the current palette without 

changing the original color 

• CONTINUEMIXINGCOLOR 

RGB 

Continue mixing the color in  the 

DesignAColor display 

RGB values are the degrees of red,  green and blue you can mix 

together to  form a color. 

To change a color by entering RGB values :  

1 .  Select RGB.  

2.  Type a degree of red value ( from 0 to 100) , and press  

< Return > . 
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3 .  Type a degree  of green value (from 0 to 100) , and press  

< Return > . 

4 .  Type a degree of blue value (from 0 to  100) , and press  

< Return > . The ROB name replaces the color  in the 

current palette .  

NOTE: The ROB values are listed as the color name in the cur­

rent  palette .  For example,  "R0500020B070" is an ROB name of 

a color composed of a red that  is 50% red, a green that i s  20% 

green,  and a blue that is 70% blue. 

HSI 

HSI values are values that represent a hue, a level of saturation, � 
and a degree  of intensity that form a color .  

To change a color by entering HSI values :  
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1 .  S elect H S I .  

2 .  Type a h u e  value (from 0 to  360) ,  and press  < Return > .  

(Some hue values are :  0 = blue, 60 = violet ,  120 = red,  

150 = orange,  180 = yellow, and 240 = green.)  

3 .  Type a saturat ion value (from 0 to 100) ,  and press  

< Return > . (0 = the most  white mixed in;  100 = pure 

color . )  

4. Type an intensity value (from 0 to 10Q) , and  press 

< Return > .  (0 = the darkest color ; 100 = the brightest  

color . )  
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The HSI  name replaces the color in the current palett e .  

NOTE: The  HSI  values a re  l isted as the  color name  in the cur­

rent  pale t te .  For example,  "H080S0301040" is  the HSI color 

name. 

Save 

S ave allows you to store the current palette permanently.  You 

can have up to  20 palet tes  in the Palet te  file .  

To save a pale t te :  

1 .  S elect Save.  

2.  Do one of the following: 

- To save th e palette under a new name 

Select NewPalette, type a name (of  up to  10 

characters) , and press  < Return > .  

- To save the palette under the name of an exist­

ing palette 

Select the name of a palette you want to  

replace.  Then, select Replace t o  replace that 

palette ,  or Quit to return to  the P alet te  menu.  

NOTE: When you save a picture or char t ,  the current palet te  is  

saved with i t .  This is  an addit i onal way of saving a palet te .  I f  you 

do not  save the changes you have made to a palet te ,  the program 
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discards the changes when you get another palette or another pic­

ture with a different palette .  

Delete 

Delete allows you to remove a saved palet te .  

To delete a palet te :  

1 .  Select Delete .  

2 .  Move the cursor to the name of the palette to  delete ,  

and press < Return > . 

Quit 

S elect Quit  to  exit the Palette menu and return to  the main menu.  
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MakeSiide & Quit Commands 

MakeSiide 

MakeSlide al lows you to transmit  images to  the MAGICorp sl ide 

service bureau for processing as high-quality 35mm sl ides ,  

transparencies ,  prints ,  or black & white copies . 

MAGICorp's  network of $250,000 Celco film recorders  produce 

images with high resolution (no j agged edges) , rich colors and 

typeset -quality fonts .  You can transmit up to  99 images at  one 

t ime.  Your MAGICorp output comes back to you via overnight 

� courier .  In  some cases ,  you can specify next day delivery. Prints 

and transparencies require an addit ional day for processing.  

B efore  transmitt ing your images,  you must have a MAGICorp 

customer s i te  code .  If your company or department does  not  al ­

ready have one,  cal l  MAGICorp at the following number to  ob­

tain one :  

1 ·800-FOR-MAGI ( 1 -800-367-6244) 

S elect MakeSi lde to choose from these menu i tems :  

• SLIDELIST Assemble a l ist  of images to  transmit 

• ORDERFORM Prepare and send images to  

� MAGICorp 

• Q UIT Return to the ImageBui lder  main menu 
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SLIDELIST 

SlideList allows you to  assemble a list of picture and chart files 

to  be sent to  MAGICorp for processing. The Slide List appears 

on the right side of the MakeSlide display. I t  contains the images 

you select for transmission and shows the directory from which 

they came . 

You can have up to  99 files in the Slide Lis t .  Press < PGUP > and 

< PGDN > to scroll the lis t .  

Select Sl ldeLlst  to  choose  from these items : 

• ADD 

• VIEWLIST 

Add picture and chart files to the S lide List � 
Scroll the Slide List to  view all the 

files it  contains 

• ERASE Clear the the Slide List 

• CHANGEDIR Change the current directory 

• QUIT Return to the MakeSlide menu 

Add 

Add allows you to add up to 99 picture and chart files to the S lide 

List to  be sent  to  MAGICorp for processing.  The cursor appears 

in the l ist  of  picture and chart files on the left side of the Make­

Slide display. Files you add to the Slide List appear on the right 
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side of the display, as shown in Figure 3-28. Use the arrow keys 

to move the cursor up, down and between the l ists .  

Figure 3-28 Adding files to the Slide List 

To pr eview a picture or chart file before adding it  to the S lide 

List ,  place the cursor over the file name and press < F6 > .  

To add a file to the Slide List :  

1 .  S elect Add. 

2 .  S elect the name of a picture or chart file on the left s ide 

of  the display. 

3. Continue selecting files until you are done.  Press 

< ESC > to return to the SlideList  menu. 

NOTE: To add the current picture or chart to the list ,  you must 

first  s ave it  by selecting File/Save. 
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View List 

ViewList  allows you to  scroll the S lide List ,  in order to  see pic­

ture and· chart files  not currently visible on the screen.  The S lide 

List may contain up to  99 files .  

To preview a picture or chart file in the Sl ide List ,  place the cur­

sor  over the file name and press < F6 > .  

To view the S lide Lis t :  

1 .  S elect  ViewList .  

2.  Use the arrow keys to move up and down the S lide List .  

Pres s  < ES C > to return to the  S lideList menu. 

Erase 

Erase allows you to  clear the Slide List of picture and chart files .  

S elect Erase to  choose from these menu items: 

• CANCEL 

• CLEARLIST 

Cancel the request to erase the 

S lide List 

Erase all picture and chart files  

from the S lide List 

To clear the Slide Li s t :  
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1 .  S elect  Erase .  

2 .  Select Cancel  to return to the S lideList menu without 

erasing, or  select ClearLlst  to  erase the Slide List .  

NOTE: Erase d o e s  n o t  affect t h e  list of picture a n d  chart files  

in the current  directory on the left s ide of the display.  

ChangeDir 

ChangeDir allows you to change the current directory in order to  

add different picture and chart files to  the Slide List .  The new 

directory name and the files it contains appear  on the left s ide of 

the display .  

To change the current directory: 

1. Select ChangeDlr. 

2 .  Do one of the following: 

- If you see the name of the directory you want 

Select the name . (The single dot  ( . )  in the l ist  

of directory names is the current directory.  

The double dot ( . . ) i s  the parent directory.)  

- If you do not  see th e name of the directory 

Select NewDirectory, then type the directory 

name, and press < Retu rn > .  
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The name of the directory and the files it contains appear on the 

screen .  

Quit 

S elect Quit  to  exit the S lideList menu and return to  the M ake­

S lide menu.  

ORDERFORM 

Order Form allows you to  prepare your images for processing and 

to  transmit them automatically to MAGICorp.  OrderForm 

provides  three forms for you to fill out before sending your im­

ages .  SCO ImageBuilder saves some of the more s tandard cus­

tomer and media information, so you may not  have to  enter it  

again. 

Select OrderForm to  choose from these i tems:  

• CUSTOMER Enter customer mailing and billing 

information 

• MEDIA Specify quantity, type, and format 

of media desired 

• PRESENTATION 

• SEND 

• QUIT 

3-126 

Enter turnaround time, presentation 

name, and comments 

Transmit images to MAGICorp 

Return to the MakeSlide menu 



Command Reference • Makeslide & Quit 

Customer 

Customer al lows you to  enter customer mailing and billing infor­

mation for MAGICorp.  Customer information includes your 

name, department ,  company name, address, phone number, and 

site code .  You only need to enter this information once .  

To enter customer information:  

1 .  S elect  Customer. A form appears on the screen. (To 

get Help on any field in the form:  press  < Fl  > .) 

2. Fill out the form by typing the required information in 

each blank field,  and pressing < Return > . 

3 .  Press  < ESC > to return to the Order Form menu.  

Site Code 

"S i te  code" identifies  your company as a MAGICorp customer . If 
your company or department does not  already have a site code, 

call  MAGICorp to obtain one at :  1 -800-FOR-MAGI ( 1 ·800-367· 

6244) . 

You will not  be able to transmit images to  MAGICorp until  you 

have entered a s i te code in the "Site code" field .  You only have 

to enter  this information once.  
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To enter a si te code:  

1 .  Type your code in the "Site code" field.  

2 .  Press < Return > . 

Name & Address 

You must enter customer mailing and billing information in the 

"Name,"  "Company," "Department , "  "Street , "  " City," "State , "  "Zip 

code" and "Phone number"  fields before transmitt ing your images 

to  MAGICorp.  You only have to enter this information once .  

To enter  customer information: 

1 .  Type the required information in each field.  

2 .  Press  < Return > . 

Media 

Media  allows y o u  to  specify the number and format of  slides,  

transparencies,  color prints,  or black & white copies you want 

processed from the images in the S lide List .  

To enter media information: 
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2. Type the number of each type of media you want 

processed,  and press < Return > . 

3 .  S elect a format choice for each type of media .  

4 .  Press  < ES C > to return to  the Order Form menu.  

Number of Slides 

"Number of sl ides"  allows you to specify the number of 35mm 

slides you want made of the images in the Slide List .  

For example,  if you have five files  in the list and you enter "2 , "  the 

Total  box tells  you that you will  receive a total  of 10 sl ides .  

To  order sl ides from MAGICorp: 

1 .  Type the number of slides you want in the box to  the 

right of  "Number of slides . "  

2 .  Press  < Return > . 

Number of Transparencies 

"Number of transparencies" allows you to  specify the number of 

overhead transparencies you want made of the images in the Slide 

Lis t .  (Allow one additional day  for processing of  transparen­

cies . )  
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For example,  if you have five files in the Slide List and you enter 

" 1 , "  the total  box tel ls  you that you wil l  receive a to tal of 5 

transparencies .  

To order transparencies from MAGICorp:  

1 .  Type the number of transparencies you want in the box 

to  the right of "Number of transparencies . " 

2 .  Press  < Return > . 

Number of Prints 

"Number of prints" allows you to  specify the number of color 

prints (8 1/2 x 11 1/2")  you want made of the images in  the S lide � 
Lis t .  (Allow one additional day for processing of print s . )  

For  example ,  i f  you  have five files in  the  Slide List and  you  enter 

"2 , "  the Total  box tells  you that you wil l  receive a to tal of 10 

print s .  

To order  prints from MAGICorp: 
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Number of Black & Whites 

" Number of black & whites"  allows you to specify the number  of 

black and white copies you want made of the images in the S lide 

Lis t .  

For  example,  i f  you  have four files in  the  Slide List and  you  enter 

"2" ,  the Total  box tells  you that you wil l  receive a to ta l  of  8 black 

& white copies .  

B lack & whites can serve a s  a record of a sl ide presentat ion,  or  

as hardcopy handouts or camera ready copy. 

To order black & whites from MAGICorp:  

1 .  Type the number of black & white copies  you want in 

the box to  the right of "Number of black & whites . "  

2 .  Press  < Return > . 

Slide Mounting 

"Sl ide mounting" allows you to select a slide mounting (frame 

style) . Move the cursor to the style you want,  and press  

< Return > :  

• Standard 

• Wess 

Give sl ides a s tandard plast ic frame 

Give slides a heat-resistant  glass frame 

that protects them from warping from 
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• Unmounted 

repeated use in a sl ide proj ector 

(good for frequently used slides) 

Give slides no frame 

Transparency Mounting 

"Transparencies"  allows you to  select a transparency mounting 

(frame style) . Move the cursor to the style you want, and press 

< Return > :  

• Mounted Give transparencies a cardboard frame 

• Unmounted Give transparencies no frame 

Print Finish 

"Print finish" allows you to  select a print finish for  your  colored 

prints .  Move the cursor to  the finish you want, and press  

< Return > :  

• Glossy Give prints  a shiny surface 

• Matte  Give prints a flat ,  nonreflecting surface 

Black & White Foreground 

"Black & white  foreground" allows you to select a drawing style 

for obj ects in your black & white copi es .  Mov� the cursor to  the 

drawing style you want, and press < Return > : 
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Represent the colors of obj ects  as patterns 

Represent the colors of obj ects  as black 

(good select ion for text char t s )  

Black & White Header 

"Black & white header"  gives you the option of adding a header 

to  your black & white copies .  Headers consist  of  the name of 

your picture or  chart ,  your site code, and the presentat ion name 

( if  you have one ) .  

To a d d  or  remove headers from your black & whites ,  move the 

cursor to  one of these choices,  and press < Return > : 

• Not Printed Omit a header on black & white copies 

• Printed Print  a header on black & white  copies 

Presentation 

Presentat ion allows you to enter information about your presen­

tat ion and to  specify a turnaround time . 

To enter presentation information: 

1.  S elect  Presentation .  A form appears on the screen. (To 

get Help on any field in the form:  press  < Fl > . )  

2 .  S e lect a turnaround - t ime pr io rity . 

3 .  Enter  a presentation name and comments  (opt iona l ) . 
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4. Press  < ES C > to return to the Order Form menu. 

Priority 

"Priority" allows you to  select a turnaround-time priority for the 

processing and delivery of your order.  

To select a priority, move the cursor to  one of the following 

choices, and press < Return > : 

• Normal 

• Rush 

Orders received by MAGICorp any busi­

ness day are shipped to  you the next day 

by overnight courier 

Orders received by MAGICorp by 

9 :00 a .m.  (EST) any business day are 

shipped to you the same day by 

overnight courier 

NOTE: Transparencies and color prints require an additional 

day for processing. 

Presentation Name 

"Presentation name" allows you to enter an optional name for 

your presentation. The presentation name appears on the work­

order summary sheet you receive with your returned order . 
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To enter a presentation name: 

1 .  Type a name (up to  15 characters) in the "Presentation 

name" field .  

2 .  Press  < Return > . 

Comments 

" Comments"  allows you to enter optional comments t o  communi­

cate requests  to  MAGICorp or make notes to yourself. 

MAGICorp reads your comments before processing your order .  

Comments  appear on the work-order summary sheet when your 

order is  returned.  

To  enter comments :  

1 .  Type a l ine of text (up to 40 characters) on  the firs t  

" Comments" l ine.  

2 .  Press < Return > .  

You can enter up to three lines of comments .  

Send 

S end allows you to  transmit the images in the Slide List  t o  

MAGICorp for processing . 

To send your images :  
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1 .  S elect Send. The total number of each media you have 

ordered appears on the screen for your reference .  · 

Check to  be  sure this is the correct number  of s l ides ,  

transparencies ,  prints ,  and/or black & white copies you 

want to  receive from MAGICorp. 

2 .  S elect Yes to transmit the images ,  or No to return to  the 

OrderForm menu without transmitting. 

Quit 

Select Quit to  exit the OrderForm menu and return to  the Make­

Slide menu.  

QUIT 

S elect Quit to  exit the MakeSlide menu and return to  the SCO 

ImageBuilder main  menu.  

QUIT or RETURNTOPRO 

Quit allows you to exit SCO ImageBuilder .  

I f  you entered the program from SCO Professional ,  you can in­

stantly select ReturnTo Pro by pressing < FlO > . (The cursor 

must be in a menu when you press < FlO > .) You return to  SCO 

Professional .  

I f  you entered the program from the operating sys tem,  press  

< ES C > or select Quit until you re turn  to the main menu.  Select 
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Qui t  from the main menu. You are presented with two choices :  

• RESUMEPRO GRAM 

Cancel the request to  exit the program 

• QUI1 PRO GRAM 

Exit SCO ImageBuilder 

To  exit the program: 

1 .  Se lect Quit .  ( If  your picture or chart is unsaved, you 

receive a warning message. Press < ES C > to  continue . )  

2 .  S elect  QuitProgram to leave the  program, or Resume·  

Program to re turn to the  SCO ImageBuilder main menu.  
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APPENDIX A: SCO I mageBuilder Keys 

The following keys perform the functions described below: 

< Return > 

Appendix A 

Select highlighted commands or options on the menu line, fields in a 

display, and objects in the Draw graphics area. Complete some ac­

tions. 

< BKSP >  

Undo the last action. Erase text to the left of the cursor, one charac­

ter at a time. 

� < ESC > 

Return to a menu one level above the current menu. Leave the on­

line Help system. Complete some actions in the graphics area. 

< ARROW KEYS > 

Move the cursor to a menu command or option on the menu line, to a 

field in a display, or to a different location in the Draw graphics area. 

-+ < RIGHT > Move the cursor to the right. 

- < LEFT > Move the cursor to the left. 

t < UP >  Move the cursor up. 

� � < DOWN > Move the cursor down. 
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< Shift > < Arrow Keys > 

Move the cursor very small steps in the Draw graphics area. 

< ? >  

Get Help on any highlighted command or option. 

< ! >  

Perform a Shell Escape to temporarily leave SCO ImageBuilder and 

return to the operating system. (Type "exit" and press < Return > to 

reenter the program.) 

< Space Bar > 

Interrupt redrawing of the graphics area. Erase a value or label in 

the Data display. 

< PGUP > 

Move the cursor diagonally (up and right) in the Draw graphics area. 

Go to the previous page of Help. Scroll up some lists. 

< PGDN > 

Move the cursor diagonally (down and right) in the Draw graphics 

area. Go to the next page of Help. Scroll down some lists. 

< Home > 

Move the cursor diago!lally (up and left) in the Draw graphics area. 

Go to the flrst command, option, or fleld in a display or list .  

< End > 

A-2 

Move the cursor diagonally (down and left) in the Draw graphics 

area. Go to the last command, option, or fleld in a display or list. 



Appendix A 

< Shift > < Numeric Pad 5 > 

Center the cursor in the Draw graphics area. 

Function Keys 

(If your keyboard does not have function keys, you can perform the 

functions by typing: < Ctrl > < F > < 1-2-3-4-5-6-7-8-9 or 0. > ) 

< Fl >  (HELP) 

Get Help on any command or option on the menu line, or field in a 

display. 

< F2 > (MOUSE) 

Turn on a mouse or tablet attached to your computer. Turn off the 

mouse or tablet. 

< F3 > (INSERT) 

Insert a value or label in a data set. 

< F4 >  (DELETE) 

Delete a value or label in the Data display to shorten a data set. 

Delete a text character as you enter text. 

< F5 > (AUTOMATIC REDRAW) 

Automatically redraw the screen each time you modify an object in 

the Draw graphics area. Turn off the automatic redraw function. 

< F6 > (PREVIEW) 

Preview picture or chart file listed in the MakeSlide or File displays. 
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< F9 >  (REDRAW) 

Redraw the screen. 

< FlO > (QUICK EXIT) 

A-4 

Quickly exit sea ImageBuilder, if you entered sea ImageBuilder 

from SCO Professional. 
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APPENDIX B: Messages 

SCO ImageBuilder's messages appear on the prompt line if you inad­

vertently make an error while operating the program. The following 

is an alphabetical list of messages that may require explanation: 

Cannot create file 

Either you have run out of disk space, or the me exists and is a "read 

only" me, or you have a directory by the same name. 

Cannot delete file 

This me cannot be removed, because you have a directory of the 

same name, or the me is write protected by the operating system. 

Cannot modify options of a symbol 

You cannot change the options of objects that have been grouped 

into a symbol. You must undo the symbol ftrst. To undo a symbol, 

select Draw/Modify/Group!UndoSymbol. 

Cannot warp text 

You cannot stretch lines of text or a symbol that contains only text. 
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B-2 

Current picture is too complex to add picture 

Either the current picture or the picture you are attempting to add is 

too complex to be combined with another picture. 

Directory not found 

Check to make sure this directory exists, and is on the expected drive. 

You may have misspelled the directory name. 

GRAPHICS ERROR: No graphic support for display, 
CGI Error # 

For some reason, CGI graphics support is not properly set up. For 

more information on how to correct this situation, look up the error 

number you see on the prompt line in the CGI manual. 

Invalid file format 

This me is not the correct type of me for this action, or it is damaged. 

INNVOCATION ERROR: IBPATH variable not set 

You are not starting the program correctly. Follow the instructions 

for starting the program in the section, "Setting Up and Starting the 

Program" in Part One: Introduction . 
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No files found 

There are no files of the desired type in the designated directory. 

Not the same type of object 

The object you selected was not the same type as the last object you 

changed, so no change occurred. Select another object of the same 

type for the same change, or change options for a different type of ob­

ject by pressing < ESC > two times, and selecting a different type of 

object. 

Output device not ready 

Check to make sure that your output device is connected to your com­

puter, and that it is turned on. Refer to the Release and Installation 

Notes that came with the SCO ImageBui/der User's Guide, or contact 

your system administrator for instructions on setting up your device. 

SERIALIZATION ERROR: Invalid serial number 

The program you installed does not have a valid serial number. Con­

tact your system administrator. 

Symbol too complex to undo action 

The rotate, move, scale, or warp action you just tried to undo cannot 

/...... be accomplished because the symbol is too complex. Simply press 
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B-4 

< ESC > and reselect the object to rotate, move, scale, or warp 

again. 

Visibility is turned otT for this data set 

Changes you make to this data set will not appear in the Chart, be­

cause visibility is turned off. To make the data set visible in the chart, 

select Draw/Opdons/VIslblllty. 
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APPEN DIX C: SCO ImageBuilder Menu 

Draw MakeSlide 
see page C-2 SlideList 

Add 

Chart View List 

see page C-3 Erase 

ChangeDir 

Background 
Quit 

Solid 
Order Form 

Shaded 
Customer 

Media 

Palette 
Presentation 

Send 
Get 

Quit 
Change 

DesignAColor 
Quit 

RGB 
Quit or 

HSI 

Save 
Return To-

Delete 
Pro 

Quit 
QuitProgram 

Resume-

Program 
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Quit Paste 

DRAW Quit Remove 

Commands Quit 

Modify 
Alter Print 

Create 
ObjectOptions Preview 

Text 
Wording Output 

Line 
Quit 

Box 
Copy File Circle 
Rotate Get Polygon 
Move Add Options 
Scale Save Text 
Warp Delete Color 
Delete ChangeDir Font 
Group Library Height 

InBox Quit Justify 
Object 

Quit 
UndoSymbol Zoom Lines 
Quit 

FullSize Color 
Order 

Magnify Pattern 
Front 

Pan Arrows 
Back 

Quit Smoothing 
Quit 

Width 
Quit 

Add Chart Quit 

Add Shapes 
Erase 

Replace BorderColor 

InteriorColor Quit 
Transfer 

� 
Pattern 

Quit Quit Copy 
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(Bar/Area/Line) Font 

CHART Color Color 

Commands Pattern Delete 

Visibility Quit 

Quit XAxis 
Data (ScatterPlot) Enter 

DataEntry Color Font 
Calendar MarkerStyle Color 
EraseData Visibility Delete 
Quit Quit Quit 

(Mixed) YAxis 
Chart Type Color Enter 

VerticalBar DataSetType Font 
� Line Pattern Color 

Scatter Plot MarkerStyle Delete 
Area Visibility Quit 
Mixed Quit Quit 
HorizontalBar 

Pie Layout XAxis 
Quit Titles AutoScale 

Main Scale 
Options Enter Grid 
(Pie) Font Quit 

Color Color 
Explode Delete YAxis 
Pattern Quit AutoScale 
Quit Subtitle Scale 

Enter 
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C-4 

Precision 

NoDecimals 

OneDecimal 

TwoDecimals 

Dollars 

Grid 

Quit 

Legend 

Legend Off 

Legendlnside 

Legend Outside 

Stack 

Quit 

Erase 

Transfer 
Copy 

Paste 

Remove 

Quit 

Print 
Preview 

Output 

File 
Get 

Save 

Delete 

ChangeDir 

ImportWKS 

Quit 

Quit 
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APPENDIX D: Symbol Library 

A symbol library is a collection of pre-drawn clip art, including maps, men, 

women, buildings and objects. SCO ImageBuilder comes with a library of 

symbols you can incorporate into your pictures and charts to add variety 

and interest. 

To access the symbol library, you must be in the Draw menu. Once you 

add a symbol to the Draw graphics area, you may change it with the 

Modify commands. You can copy, rotate, move, scale or warp the symbol 

as a whole unit. You can also undo the symbol and edit the options of its 

individual objects. 

To add a symbol to the Draw graphics area: 

1 .  Select File. 

2. Select Library. The names of symbols in the library appear on 

the screen. (To preview a symbol, press < F6 > .) 

3. Select the name of a symbol. 

NOTE: You cannot save symbols to or delete symbols from the symbol 

library. 
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A u t o m a t ic red raw 2 - 1 6  (for new obj ec t s )  3 -76 

A u t oScale  3-93 options 

Axis  prec i s i o n  3-95 (for exi s t i n g  obj e c t s )  3 - 3 1  

p a l e t t e  colors 3 - 1 1 1  

palet tes 3 - 1 09 

B text 3-32 

Chart 3 - 1 , 3 - 6 1  

B a c kgro u n d  3 - 1 ,  3 - 1 0 7  defi n i t i o n  3 - 6 1  

s o l i d  3 - 1 07 graphics  area 3 - 6 1  

gra d a t e d  3 - 1 08 m e n u  3 - 6 2  

Bar  c h a r t  options 3 - 76 

h orizon t a l  3 - 73 t i t les  3-85 

vert ical  3-68 Chart commands 3-61  

B&W fo regro u n d  3 - 1 32 Charts  

B & W  header 3 - 1 33 See D a t a  c h a r t s  

BorderColor 3-25 Chart  Type 3-66 

� Box 3 - 1 0  Circle 3 - 1 1  

o p t i o n s  3- 1 0  C l i pb o a rd 3-99 
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Color 3-77,  3 - 107,  3 - 1 1 4  adding t o  D raw 3-56 

for data charts 1 -9 area chart 3-71 � 
for text charts  1 -7 chart types 3-66 

HSI 3 - 1 1 9  creat ing good charts  1 -7 

l i n e  3-20 defau l t  1 -7 

m e t hods for c re a t i n g  3 - 1 1 1  definit ion 3-61 

m ixing 3 - 1 09 horizontal  b a r  chart  3 - 73 

on devices 3 - 109 labels 1 -9 

p a l e t t e s  3 - 1 09 l i n e  chart 3-69 

ROB 3 - 1 1 8  mixed chart 3 - 72 

text 3 - 15 options 3 - 76 

Color prints  pie chart 3 - 75 

See Prints  scatter  chart 3 - 70 

Combining t u t orial  lesson 2-8 

data charts  3-59 two o n  a page 3 -5 7, 3-59 

p i c t u re s  3-50 use o f  data 1 -9 

Command vertical  bar  3-68 

defini t ion 1-10  D a t a  display 3-63 

se lect ing  1-13  erasing 3 -66 l 
Comments  3 - 1 35 D a t a  entry 3-64 

Copy 3-33,  3 -44,  3-99 t u torial  2-8 

C re a t e  3 -5 D a t a  set  

Curre n t  chart  3-61 changing options fo r 3-76 

C urre n t  p i c t u re 3-3 changing type 3-82 

Cursor definition 3-64 

keys 1 - 15 entering names 3-65 

m oving in D raw 1 - 1 2  making vis ible  3 - 79 

on m e n u  l i n e  1 - 1 3  DataEntry 3-64 

Customer 3 - 1 2 7  DataSetType 3-82 

Delete  3 - 5 2 ,  3 -90,  3 - 1 04 

D 
Delet ing 

a chart 3 - 1 04 

a picture 3 -4 3  

D a t a  3-63 a Clipboard i t e m  3 - 1 00 

e n t e ring 3-64 color palettes  3 - 1 20 

D a t a  charts  1 -7 data va l u es 3-65 ·� 
key 1 - 1 7  
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p a l e t t e s  3 - 1 20 

t i t l e s  3-90 

D e s ignAColor 3 - 1 1 3  G 
D raw 3-3 

D rawi ng c o m m a n d s  3-4 G e t  3-48,  3 - 1 03 ,  3 - 1 1 0  

G e t t i n g  

E a chart  3 - 1 0 3  

a p a l e t t e  3 - 1 1 0  

a picture 3-48 

E n d i n g  the session 3 - 1 36 G raphics 1 -1 

Enhancing c h a rt s  good d a t a  charts  1 -7 

a d d i n g  to D raw 3-56 good text c h a rt s  1 -5 

t u t oria l  lesson 2 - 1 2  t ips 1 -4 

Enter  3-88 G raphics area 1 - 1 1  

Entering d a t a  3-63 - 3-64 e rasing D raw 3-43 

Erase 3 -4 3 ,  3 - 9 8 ,  3 - 1 24 e rasing Chart  3-98 

Erase D a ta 3-66 m ovin g  t h e  cursor 1 - 1 2  

� Error m essages B-1 Grid 3 - 94 

Exi t i n g  t h e  program 3 - 1 36 G roup 3-37 

Exp lode 3-78 

H 
F 

Height  3 - 1 7  

Fi le  3-47,  3 - 1 02 Help 

Fi le  opera tions 3 - 1 02 gett ing 1 - 18 

Font  3 - 1 6, 3-89 key 1 - 17 

c h o ices 3 - 1 7  H orizon t a i B a r  c h a rt 3-73 

choosing 1 -7 H S I  3 - 1 18  

Front 3-41 Hue 3 - 1 14 

F u i iSize 3-55 

Funct ion Keys A-3 

I 

� lmportWKS 3 - 1 06 

I n  Box 3-38 
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I nsert ing 

d a t a  va lues  3-65 

key 1 - 1 7  M 
I n t e n s i ty 3 - 1 1 6  

l nteriorColor 3-25 MAGI Corp 

customer i n fo 3 - 1 2 7  

J 
media i n fo 3 - 1 28 

order forms 3 - 1 26 

s i t e  code 3 - 1 27 

J u s t i fy 3 - 1 8  transmitt ing fi les 3 - 1 35 

turn-around t i m e  3 - 1 34 

t u torial  lesson 2 - 1 8  

K Magnify 3-55 

Main 3-86 

Keyboard M a i n  menu 3 - 1  

function keys A-3 MakeS ! ide 3-2 ,  3 - 1 2 1  

key t a b l e  1 - 1 ,  A - 1  M a k i n g  presenta tions 1 -4 

us ing k eyboard 1 - 14 Making sl ides 3 - 1 2 1  � t utorial  le sson 2 - 1 8  

Making transparencies 3 - 1 2 1  

L Managing fi les 3-47 

MarkerStyle 3-82 

Media 3 - 1 2 8  
Layo u t  3-83 

o f  data  c h a rt s  1 -8 
Choosing a medium 1 - 1  

M e n u  1 - 1 0  
o f  text charts  1 -6 

main 3 - 1  
Legend 3-95 

labels  3-65 
selecting from 1 - 1 3  

Library of symbols  D - 1  
selecting options 1 - 1 3  

s truc t u re C - 1  
Line 3-8 

M e n u  l ine 1 - 1 1  
Line chart  3-69 

options 3-9 ,  3-20  
Messages B - 1  

M ixed chart 3 -72 
Line p a t t erns 3-80 

Lines 3 - 1 9  
Modify 3-28 

Modifying palettes  3 - 1 1 1  

Mouse 

b u t tons 1 - 1 8  � 
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key 1 - 1 7  transparencies  1 -3 

M ove 3-35 paper 1 -2 

M ovi n g  the c u rsor 1 - 1 2  printed 1 -2 

print ing 3 - 1 0 1  

N a m e  & address 3 - 1 28 via s l i d e  service 3 - 1 2 1  

N u m b e r  of b lack & whites 3 - 1 3 1  Overhead t ranspare ncies  

N u m b e r  of prints  3 - 1 30 See Transparencies 

Number of s l i d e s  3 - 1 29 

N u m b e r  of transparencies 3 - 1 29 

p 
0 P a l e t te 3 - 1 ,  3 - 1 09 

a d d i n g  a color 3 - 1 1 7  

O bj ect  3-39 changing a color 3 - 1 1 1  

Obj ec t O p t ions 3-31  defin i t i o n  3 - 1 09 

O bj ec t s  P a n  3-56 

changing op tions for 3-31  Paper output  1 -2 

c opyi ng 3-33 Paste 3-45 , 3 - 1 00 

c re a t i n g  3 -5 P a t t e rn 3- 2 1 ,  3-26 ,  3-80  

d e l e t i n g  3-37 P i c t u re 3-3  

gro u p i n g  into  symbol  3-37  combining 3-50 

m ov i n g  3-35 d e l e t i n g  a fi le 3-52 

ordering 3-40 gett ing 3-48 

rot a t i n g  3-34 saving 3 - 5 1  

scal ing 3-35 zoo m i n g  3 - 5 4  

warping 3-36 Pie c h a rt 3 - 75 

Options 3 - 1 3 ,  3-76 Pie s l ice 

b ox 3 - 1 0  changing op tions  for 3 - 76 

circle  3 - 1 1  exploding 3 - 78 

l i n e  3 - 9  Pie  s l i c e  l a b e l s  3 - 64 

p olygon 3 - 1 3  P l o t t e r  o u t p u t  1 - 2 ,  3 - 4 6 ,  3 - 1 02 

t ext  3-8 b a c kgro u n d  color 3 - 1 07 

O rd e r  3-40 Polygon 3 - 1 2  

O rd erForm 3 - 1 26 options 3 - 1 3  

� O u t p u t  3-46,  3 - 1 02 Precision 3-94 

3 5 m m  s l i d e s  1 -2 P rese n t a t i o n  3 - 1 33 
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P rese n t a t i o n  name 3 - 1 34 Saving 

Prese n t a t ions a chart  3 -1 04 

t ra nsparencies 1 -3 a palette 3 - 1 1 9  

paper h a n d o u t s  1 -2 a picture 3 -5 1  

t ips  1 -4 Scale 3-35,  3-92 

35 m m  sl ides  1 -2 Scaling an axis 3-92 

using M A G ICorp 3 - 1 2 1  Sca t t erPiot chart  3 - 70 

Preview 3-46, 3 - 1 02 SCO FoxBASE 1 -8 ,  3-64 

Printer  o u t p u t  1 - 1 , 3-46,  3 - 1 0 1  S C O  ImageBuilder 

b a c kgro u n d  color 3 - 1 0 7  chart types 3-66 

Prints  data  charts  1 -7 

f inish 3 - 1 32 e rror messages B - 1  

n u m b e r  t o  order 3 - 1 30 keys A - 1 , 1 - 1  

Priority 3 - 1 34 main menu 3-1  

Prompt l ine 1 - 1 1  menu structure C - 1  

purpose o f  1 - 1  

screen 1 - 10 

Q starting t h e  progra m 1 - 1 0  

t utorial  2-1 � 
Q u i t  3 - 2 ,  3 - 1 07 ,  3 - 1 36 using t h e  program 1 -9 

Q u i tt i n g  t h e  progra m 3 - 1 36 SCO Professional  

Scrol l ing 

1 -8 ,  3-64 

keys 1 - 1 6  

R options menus 1 - 1 3  

Selecting 

a command 1 - 1 3  
Rem ove 3 - 1 00 

an option 1 - 1 3  
Reordering obj ects  3-41  

Send 3 - 1 35 
ROB 3 - 1 1 7  

Shaded b a ckground 3 - 1 08 
Rot a t e  3-34 

Shapes 3-24 

Shel l  escape 1 - 15 

s Site  code 3 - 1 27 

Sl ide l ist  

assem b l i n g  3 - 1 22 

S a t u rat ion 3 - 1 15 e rasing 3 - 1 24 

Save 3-5 1 ,  3 - 1 05 ,  3 - 1 1 9  Sl ide List 3 - 1 22 � 
Slide mou n t i n g  3 - 1 3 1  
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� Smoot h i n g  3-22 i n  prese n t a t ions 1 -3 

S o l i d  3 - 1 0 7  m o u n t i n g  3 - 1 3 1  

S o l i d  b a c kg ro u n d  3 - 1 07 n um b e r  to order 3 - 1 29 

S t a c k  3-98 u s i ng slide service 3 - 1 2 1  

S t a r t i n g  t h e  program 1 - 1 0  Tra nspare ncy m o u n t i n g  3 - 1 32 

S u b t i t l e  3-86 Tutorial  2 - 1  

Symbol  

chart  symbol  3-59 

c re a t i n g  3-38 - 3-39 u 
defin i t i o n  3-37 

l i b rary D - 1  U nd oSym b o l  3 - 3 9  
u nd o i n g  3-39 Using t h e  p rogram 1 -9 

T v 

Tab let  Values  3 - 64 

� b u t tons 1 - 1 8  Vertica iBar  c h a rt 3-68 
key 1 - 1 7  ViewList  3 - 1 24 

Templ a t e  l i b r a ry D - 1  V i s i b i l i ty 3 - 79 
Text 

c o m m a nd 3-7  

j us t i fi c a t i on 3 - 1 9  w 
options 3-8 

Text charts  1 -5 

c re a t i n g  good ones  1 -5 
Warp 3-36 

margins 1 -5 
Width  3-23 

tutorial  lesson 2-2 
Word i ng 3-32 

35mm S l i d e s  

m o u n t i n g  3 - 1 3 1  X 
n u m b e r  to order 3 - 1 29 

prese n t a t ions 1 -2 

u s i n g  s l i d e  s e rvice 3 - 1 2 1  XAxis  3 - 8 7, 3-90 

Tit les  3-85 s c a l i ng 3-92 

Tra nsfe r  3 -4 3 ' 3-99 t i t l e  3-87 

Transpare n c i e s  X - a x i s  labels  
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i nsert ing 

m o n t h ly 

Y Axis 

z 

l a b e l  precision 

scal ing 

t i t le  

Zoom 

1-8 

3-65 

3-65 

3 -87, 3 - 9 1  

3-94 

3-92 

3-87 
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